NX 10.0.3 Release Notes
Welcome to NX 10.0.3

November 2015

Dear Customer:

We are proud to introduce NX 10.0.3, the latest release of our NX product development solution. NX 10.0.3 is a major release with significant new functionality in all areas of the product and we believe that the new and enhanced functions will help you become more productive.

Siemens PLM Software has a clear and consistent strategy: to provide Digital Product Development and Manufacturing solutions that help you transform your whole product development process. This release delivers enhancements that enable you to increase your levels of productivity in product development and manufacturing while working within a collaborative managed environment.

Summary

With the NX 10.0.3 release, we continue to look for innovative ways to deliver solutions that meet your product development and manufacturing challenges.

We are confident that our accomplishment of these objectives will enable you to extract the highest value from our solutions. For a complete overview of all enhancements and for additional information about this release, refer to these Release Notes as well as the What's New Guide included with the NX 10.0.3 Help.

Sincerely,

Your NX 10.0.3 Team
Contents

Welcome to NX 10.0.3 ......................................................... 2

System Information ........................................................... 1-1
Customer support ............................................................ 1-2
Version up testing ............................................................. 1-3
Platforms ................................................................. 1-3
  System requirements guidelines ........................................... 1-3
  Operating system requirements ........................................... 1-5
Mac OS X Support .......................................................... 1-9
Linux graphics caveats ................................................... 1-13
Supported hardware and graphics ....................................... 1-14
Initializing the JVM ....................................................... 1-15
NX variables in the ugi_env.dat file ................................... 1-16
Browser requirements ..................................................... 1-17
  Browser and plug-in requirements ..................................... 1-17
  Browser caveats ....................................................... 1-19
Licensing Caveats .......................................................... 1-20
  General licensing caveats ............................................. 1-20
  Licensing caveats for Windows ...................................... 1-21
  Licensing caveats for Linux .......................................... 1-22
  Licensing caveats for Mac OS X ..................................... 1-23
Product compatibility - supported version combinations ......... 1-25
NX compatibility with Spreadsheet ..................................... 1-27
NX applications unsupported on specific platforms ............... 1-28
Support for touch enabled devices ................................... 1-29

Fundamentals ............................................................... 2-1
Product Notes ............................................................. 2-2
Caveats ................................................................. 2-3

CAD ................................................................. 3-1
Modeling ................................................................. 3-1
  Product Notes ........................................................ 3-1
  Caveats .............................................................. 3-2
Drafting ................................................................. 3-2
  Product Notes ........................................................ 3-2
  Caveats .............................................................. 3-4
  Documentation Notes ................................................ 3-5
Assemblies ............................................................... 3-5
  Product Notes ........................................................ 3-5
  Caveats .............................................................. 3-7
Visual Reporting .......................................................... 3-8
## Contents

### Caveats
- Data Reuse ................................................................. 3-8
- Product Notes ............................................................ 3-8
- Sheet Metal ................................................................. 3-9
  - Caveats ................................................................. 3-9
  - Documentation note .................................................. 3-10
- Routing .............................................................................. 3-10
  - Caveats ................................................................. 3-10
  - Documentation Notes .................................................. 3-12
  - Product Notes .......................................................... 3-13
- PMI ................................................................................ 3-13
  - Product Notes .......................................................... 3-13
- PCB Exchange .............................................................. 3-13
  - Caveats ................................................................. 3-13

### CAM ............................................................................. 4-1
- Manufacturing Product Notes .......................................... 4-1
  - Manufacturing Product Notes ....................................... 4-1
  - CAM Early Adopter program ....................................... 4-2
  - Tool path and template changes .................................... 4-3
  - Preliminary Post Configurator documentation .................. 4-9
  - Preliminary Robotic Machining documentation ............... 4-10
  - General changes ....................................................... 4-11
  - On-machine probing ................................................... 4-13
  - Feature-based Machining (FBM) .................................... 4-14
  - Manufacturing critical maintenance and retirement notices 4-15
  - Integrated Simulation and Verification (ISV) ................. 4-16
- Manufacturing caveats .................................................... 4-16
  - General caveats ....................................................... 4-16
  - Manufacturing documentation caveats .......................... 4-17
  - Milling caveats .......................................................... 4-20
  - Hole machining caveats .............................................. 4-25
  - ISV caveats ............................................................... 4-26
  - Turning caveats .......................................................... 4-28
  - Post Configurator caveats ............................................ 4-29

### CAE ............................................................................. 5-1
- Advanced Simulation ..................................................... 5-1
  - Product Notes .......................................................... 5-1
  - Caveats ................................................................. 5-2

### Programming Tools ...................................................... 6-1

### Inspection and validation .................................................. 7-1
- Check-Mate and Requirements Validation ......................... 7-1
  - Caveats ................................................................. 7-1
- CMM Inspection Programming ........................................... 7-1
  - CMM release notes ...................................................... 7-1
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caveats</td>
<td>7-2</td>
</tr>
<tr>
<td><strong>Tooling Design</strong></td>
<td>8-1</td>
</tr>
<tr>
<td>Mold Wizard simulation enhancements (10.0.3)</td>
<td>8-2</td>
</tr>
<tr>
<td>Mold flow analysis</td>
<td>8-4</td>
</tr>
<tr>
<td>Tooling Design documentation</td>
<td>8-5</td>
</tr>
<tr>
<td><strong>Data translation</strong></td>
<td>9-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td>9-2</td>
</tr>
<tr>
<td>Caveats</td>
<td>9-3</td>
</tr>
<tr>
<td><strong>Teamcenter integration</strong></td>
<td>10-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td>10-2</td>
</tr>
<tr>
<td>Caveats</td>
<td>10-5</td>
</tr>
<tr>
<td>Documentation Notes</td>
<td>10-8</td>
</tr>
<tr>
<td><strong>Mechatronics Concept Designer</strong></td>
<td>11-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td>11-2</td>
</tr>
<tr>
<td><strong>Line Designer</strong></td>
<td>12-1</td>
</tr>
<tr>
<td>Product notes</td>
<td>12-2</td>
</tr>
<tr>
<td>Documentation notes</td>
<td>12-3</td>
</tr>
<tr>
<td>Caveats</td>
<td>12-4</td>
</tr>
<tr>
<td>Caveats (10.0.2)</td>
<td>12-5</td>
</tr>
<tr>
<td>Caveats (NX 10.0.3)</td>
<td>12-6</td>
</tr>
</tbody>
</table>
Chapter 1: System Information
**Customer support**

Customers covered by valid maintenance agreements are eligible to receive telephone and web support from the Global Technical Access Center (GTAC) on issues regarding any current or past release. We will always assist our customers to the best of our ability.

To report serious problems against supported releases, please contact your local GTAC support center [http://support.industrysoftware.automation.siemens.com/services/global_number.pdf](http://support.industrysoftware.automation.siemens.com/services/global_number.pdf).

For additional information on GTAC services, visit our support pages at [http://www.siemens.com/gtac](http://www.siemens.com/gtac) and review our featured services.
Version up testing

Version up testing helps you to ensure that your existing data will version up smoothly to the latest release of NX. Along with our pre-release NX software, we provide an automated application that checks part features, drawings, and smart model data to make sure that they are compatible with the latest release of NX. You can use this application to test a large collection of data with minimum intervention. You can submit parts with detected problems for further evaluation by Siemens PLM Software by submitting problem reports through normal GTAC processes.

If you are interested in version up testing, refer to the following directories for the appropriate README files and associated utilities.

For feature modeling: .../ugsamples/update_all_features
For drawings: .../ugsamples/update_all_drawings
For smart models: .../ugsamples/update_all_smartmodels

Platforms

System requirements guidelines

Defining the minimum system requirements is difficult because key requirements, most notably memory, can vary dramatically from user to user. The following are general guidelines that you should consider before purchasing a system.

Processor performance

Although raw processor speed has a major impact on system performance, other factors also contribute to overall performance; for example, the type of disk drive (SCSI, ATA, or Serial ATA), disk speed, memory speed, graphics adapter, and bus speeds. The general rule is that "the faster the processor, the better the performance is," but this only applies when comparing like architectures. For example, it is difficult to arrive at performance expectations for an Intel processor when compared to an AMD processor just by looking at their respective processor speeds. There is also a general trend today to de-emphasize processor speeds and move to multi-core processors, which actually can have lower processor speeds.

SMP

Symmetric Multiprocessing (SMP) is supported in NX mostly via Parasolid, although a small number of NX capabilities have some threading. In general, it is not possible to quote a figure for the general performance improvement achieved by using SMP, since this improvement depends on the nature of the operations you are performing. You need to evaluate your actual performance gains using your own models. Functional areas that are SMP enabled in Parasolid include:

- Validity checking
- Boolean operations
- Wireframe
- Rendering
• Hidden line rendering
• Closest approach
• Faceting
• Mass properties

SMP is enabled by default with the variable UGII_SMP_ENABLE, which is located in the ugii_env_ug.dat file.

Multi-Core

Multi-core processors are similar to SMP because there are two or more actual processor cores but they are delivered in single processor packages. Siemens PLM Software has found that multi-core performance characteristics are similar to SMP. The one advantage of multi-core processors over SMP is that this technology has proliferated much faster than SMP and is now common in workstations, servers, and laptops.

Multi-core technology is complex and, depending on the configuration, can actually have a negative impact on performance. This is due to the potential conflict of multiple cores sharing system resources, such as cache, memory, and bus bandwidth, as well the need for the system to manage and control an increasing number of cores. Increasing the number of cores does not always translate into better performance. Although additional cores can improve NX performance, processor speed is still a vital measurement of NX performance.

Many systems enable you to turn off cores via the bios, which can enable you to compare performance with a different number of cores that are active. Some users may find that turning off some cores will actually improve performance. One micro-architecture (Intel) even does this automatically, shutting down unused cores and increasing the clock speed of the others.

The hardware vendors continue to improve their processor micro-architectures to better address the limitations of older multi-core technologies. New subsystems better integrate memory and other peripherals directly to the processors, resulting in major performance improvements. Buses are being eliminated, cores are better managed, and channel speeds continue to improve.

In summary:
• Turn SMP on only if you have an SMP system. Having it on in a single-processor system incurs a slight overhead.
• Turn SMP on if you have a multi-core system.
• Never assume that by simply adding more cores you will see better performance. Always test first.

Memory

For Windows 7, the minimum amount of memory is 4 GB, but we recommend 8 GB or 16 GB of memory as a starting point. Large models and assemblies or running multiple processes concurrently could boost the required memory for adequate performance.
Graphics adapters

All the NX certified systems contain graphics adapters that meet all Siemens PLM Software requirements and are fully supported by our hardware partners. The graphics adapters supported are carefully selected by working with our OEM partners as well as our graphics vendor partners. We do not recommend low-end, consumer, or game cards, since these graphics devices are developed for the DirectX market and are not well supported under OpenGL. Because a majority of platform/hardware problems are graphics related, it is critical that all the graphics adapters that NX supports are designed for OpenGL and have the highest level of support from our hardware vendors. We highly recommend that you only use supported graphics adapters and Siemens PLM Software certified drivers.

If you are running Microsoft Windows 7 you will require graphics adapters with more on-board memory, especially when AERO (the enhanced 3D feature) is turned on. The minimum recommended graphics on-board memory is 256 MB, and although graphics adapters with less memory will work, the performance may not be adequate, even with AERO turned off. If you have high-end graphics requirements, you will need to consider graphics adapters with 512 MB or higher on-board memory.

For the latest information on certified graphics cards and driver versions, please visit the Customer Support (GTAC) Web site.

Multiple monitors

Siemens PLM Software supports multi-monitors but with limitations. These limitations were necessary due to the large number of possible configurations. Other combinations may work, but these conditions are tested and supported by Siemens PLM Software. These guidelines could be extended or relaxed in the future.

The following is a summary of findings for the support of multiple monitors.

- NX 6.0.1 or higher - no older releases are supported.
- Two monitors only.
- LCD monitors only
- Run with native resolution and aspect ratio.
- Laptops are tested without docking stations or port replicators (direct connection only).
- Horizontal Scan mode (not Vertical) and only with identical monitors.
- Dual View (Nvidia) or Extended View (ATI) modes, but the user must have the display window entirely in either the primary or secondary monitor.

You do not have to comply with the configurations mentioned above, but Siemens must be able to duplicate the problem on the configurations in our labs before being able to investigate your issues.

Operating system requirements

Operating system requirements

This section documents operating system and service pack requirements.
Minimum Certified Operating Systems

The following operating systems are certified and the minimum recommended for NX 10.0.3. Newer versions and service packs are certified as they are released.

<table>
<thead>
<tr>
<th>O.S.</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows (64-bit)</td>
<td>Microsoft Windows 7 Pro and Enterprise editions</td>
</tr>
<tr>
<td>Linux (64-bit)</td>
<td>SuSE Linux Enterprise Server/Desktop 11 SP1</td>
</tr>
<tr>
<td></td>
<td>Red Hat Enterprise Linux Server/Desktop 6.0</td>
</tr>
<tr>
<td>Mac OS X</td>
<td>Version 10.8.5</td>
</tr>
</tbody>
</table>

Windows XP and Vista

Windows XP support from Microsoft has ended and Vista was rarely deployed so these two versions of Windows are not supported by NX 10. Siemens PLM Software has not performed testing on these versions and cannot resolve any issues related to NX 10 running on these operating systems. If NX 10 is deployed on these versions of Windows, any issues will have to be replicated on Windows 7 before filing an incident report with GTAC.

Considerations and Caveats

End of Support for NX 32-bit

The memory addressing limitations of 32-bit processing and the widespread deployment of 64-bit systems has pushed OS providers, hardware vendors, and application developers to migrate their products to the 64-bit version. As a result, NX 10.0.3 is available as 64-bit only and customers will need to migrate to the 64-bit version, if they have not already done so.

Today, 64-bit processors are used in desktops, laptops, and workstations whether for consumers, gamers, or enterprise environments. The server version of Windows 7 is already 64-bit with no available 32-bit version. Siemens PLM Software supported 64-bit starting with UNIX and supported only 64-bit on Linux and Mac OS.

Microsoft Windows 8 and 8.1

Windows 8 and 8.1 were certified with NX 8.5.2 and are supported for that version and all subsequent versions of NX including NX 10.

Microsoft Windows 7

NX supports Windows 7 64-bit only; NX does not support Windows 7 32-bit. NX supports the Windows 7 Professional and Enterprise editions only.

Windows 7 requires considerably more resources (memory, disk, and so on.) than Windows XP, so it may be necessary to increase memory or disk, upgrade your graphics adapter, or even replace your workstation, to achieve the same performance available under Windows XP.
**Note**

Siemens PLM Software recommends a minimum of 4 GB of memory and a graphics adapter with at least 256 MB of on-board memory, but 512 MB or higher for those with large or complex models.

Besides the expected increases caused by this new enhanced operating system, Windows 7 has some special features that can increase memory usage quickly. The 3D desktop, user interface, and graphics capabilities of Windows 7 differ dramatically from those of Windows XP (you must think of this as a new OS and not a WXP upgrade) and can consume considerable memory resources. In addition, although Windows 7 supports OpenGL similar to previous versions, other changes in Windows have impacted the way graphics vendors use system resources (like memory). For Windows 7, the recommendation is to either increase on-board graphics adapter memory, or increase system addressable memory, or both.

Visit the Customer Support (GTAC) Web site for details of supported hardware configurations as well as for the latest graphics drivers.

**Linux Requirements**

NX supports SuSE Linux and well as Red Hat Linux, both 64-bit only. The minimum supported version of SuSE Enterprise (Desktop/Server) is 11 SP1 and Red Hat Enterprise (Desktop/Server) is 6.0. Newer versions will be supported via certification.

Visit the Customer Support (GTAC) Web site for details of supported hardware configurations as well as for the latest graphics drivers.

**Java Runtime Environment**

Starting in NX 8.5, the Java Runtime Environment (JRE) is no longer shipped with NX. NX requires JRE 8. To install the JRE, visit the Java download site at [http://java.com/en/download/index.jsp](http://java.com/en/download/index.jsp)

Java is used for the following products:

- **NX Relations Browser**
- **Product Template Studio**
- **Manufacturing – Process Studio Author**
- **Command line version of the following translators:**
  - CATIA V4
  - CATIA V5
  - Dxffdwg
  - IGES
  - NX Pro E
  - Step AP203
**Chapter 1: System Information**

- Step AP214
- Knowledge Fusion ICE
- Online Help

**Note**

NX 9.x and earlier versions contain a different Help Search that requires the latest version of the Java plugin installed as an Add On to the browser. NX 10 and later versions do not require the Java plugin for the Help Search.

- Quality Dashboard
- Validation Rule Editor
- Batch Mesher
- Customer written NX Open Java programs
- NX Response Simulation Function Tools

**Java requirements for NX Open**

NX Open for Java is designed to be used with Java version 1.8.0 or higher.

**Post Processing of Abaqus ODB format results**

In the NX 10.0.3 release, NX uses Abaqus version 6.12 libraries to process ODB results files. For NX to use these libraries, you must first install Visual C++ 2008 X64 Runtime – v9.0.30729.4967.

**Note**

If you have Abaqus version 6.12 installed on your system, the required Visual C++ runtime should already be installed.

You can download this runtime from the Simulia customer support website:
http://www.3ds.com/products-services/simulia/support/

For more information on the system requirements for ODB version 6.12 files, see:
http://www.3ds.com/support/certified-hardware/simulia-system-information/abaqus-612/system-requirements-for-abaqus-612-products

**Configuration files**

Starting with NX 10.0.3, the NX configuration files on Windows are written to
C:\users\<name>\AppData\Local\Siemens.

**Installing the .NET Framework**

The NXOpen for .NET API is a Windows-specific project that leverages the Microsoft .NET Framework component. Before you can execute a custom .NET application, you must install the .NET Framework 4.5. In addition, to replay a .NET journal, the .NET Framework 4.5 must be installed.
To download the .NET Framework 4.5, use the links on this page: Microsoft .NET Framework 4.5 (Web Installer).

Note
If you have installed Visual Studio 2012 SP1, then you have .NET Framework 4.5 installed by default.

Mac OS X Support

Hardware and installation requirements

Hardware and operating system requirements

The release of NX 10.0.3 on Mac OS X supports Apple Mac 64-bit Intel based systems. These include the MacBook Pro, iMac and Mac Pro systems. All available graphics subsystems are supported.

The minimum version of Mac OS X required to run NX 10.0.3 is version 10.8.5. Later versions of Mac OS X are also supported, but there may be caveats.

Installation of NX on Mac OS X is supported only on an HFS+ file system. However, NX part files and other data files may be stored and retrieved from an NFS file system.

X11/Motif requirements

NX 10.0.3 on Mac OS X utilizes X11/Motif to support its graphical user interface. Xquartz 2.7.5 and OpenMotif are required. You will be prompted to install Xquartz when attempting to run any X11 application for the first time and guided through the installation by those prompts. Check for Xquartz updates from the X11→Check for X11 Updates.... dialog box.

You can download Xquartz at http://www.xquartz.org/

OpenMotif must be installed prior to installing NX. Obtain the OpenMotif toolkit, openmotifcompat-2.1.32_IST.macosx10.5.dmg, from the following website:

http://www.ist-inc.com/DOWNLOADS/motif_download.html

The X11 application must be running while using NX. The X11 application is started when NX or any other X-based application is invoked.

Installation

Installation must be performed from an account with administrator privileges and must be performed on a Mac since it uses the Mac OS X Installer application.

To install, double-click the nx.10.*.mpkg file and follow the instructions presented in the installation dialog box.

Note
If the .mpkg file has a .tar.Z or .zip extension, then it is compressed. You must first double-click it to uncompress it and create the .mpkg file.
Optionally, install the online documentation by double-clicking the `ugdoc.10.*.pkg` file and following the instructions.

Optionally, install the license server by double-clicking the `ugslicensing.*.pkg` file and following the instructions. The license server will be needed if you are installing NX on a system, such as a laptop, that is not connected to a network.

**Product notes**

**Mouse focus policies**

The X11 mouse focus policy specifies how the mouse advises X11 on which window is active and can receive keystrokes. The **Click-through Inactive Windows** and **Focus Follows Mouse** operations are often preferred to the X11 defaults.

In the X11 bundled with Lion, the mouse focus policies are set by choosing X11→Preferences, Windows tab. The Windows tab contains the following options:

- **Click-through Inactive Windows**
- **Focus Follows Mouse**
- **Focus On New Windows**

You must restart X11 for a change to take effect. Note that the setting applies only to the user's own preferences, not to the system wide preferences. Refer to the `quartz-wm man` page for details.

**Pasteboard/Clipboard Setup**

The X11 Pasteboard policy defines how the Mac OS Pasteboard communicates with the X11 CLIPBOARD. To ensure proper clipboard copy/paste behavior in NX, syncing between the Mac OS Pasteboard and X11 CLIPBOARD should be disabled.

In the X11 bundled with Lion, the Pasteboard policies are set by choosing X11→Preferences, Pasteboard tab. Uncheck the **Enable syncing** option.

Note that the setting applies only to the user’s own preferences, not to the system wide preferences. Refer to the `quartz-wm man` page for details.

**3D Input Devices**

Support for 3Dconnexion input devices is available for NX on Mac OS X through the use of drivers and software available directly from 3Dconnexion. Use the following link to download the software and get installation information.

[http://www.3dconnexion.com/service/drivers.html](http://www.3dconnexion.com/service/drivers.html)

**Plotting**

MAC OS X printing systems handle PDF files in native mode. NX Plotting takes advantage of this by creating a PDF file which it hands off to a Macintosh application that handles the printing task. Because these native tools can interface with the printing system, the usual SDI plotting software used with other platforms is not used on MAC OS X.
Teamcenter Integration support for Mac OS X

Teamcenter Integration (TCIN) is supported on the Mac platform when you run in a four-tier environment. The operation and functionality of Teamcenter Integration on the Mac platform is the same as on other platforms.

Note
The Teamcenter two-tier environment is not supported.

The Mac client setup in a four-tier Teamcenter environment is similar to the setup for Linux. However, you have to install the Mac client as a TCCS installation instead of an FMS installation. Typically, the TCCS install is done as part of the RAC TC install, but since the Teamcenter RAC install does not support the Mac platform, the TCCS standalone installer needs to be used. This installer is provided on the Teamcenter Mac DVD or Mac install download. For install and setup information, see the Teamcenter installation documentation.

After installation is complete, you can create a script to setup TCIN for use before launching NX. The following is a sample script:

Note
- The values and paths used here are for example only. Use the values and paths that are applicable for your site.
- The line:
  defaults write com.siemens.plm.nx10 PIM Yes
  sets the -pim option to Yes. You can set this back to No to run native NX.
- You do not set the user name (-u) and password (-p) options in the script. You enter these in the dialog box that is displayed when you run NX.

Sample script:

```
defaults write com.siemens.plm.nx10 FMS_HOME /home/UGS/Teamcenter/Tc10/tccs
defaults write com.siemens.plm.nx10 UGII_UGMGR_HTTP_URL http://annpc38:7001/tc/aiws/aiwebservice
defaults write com.siemens.plm.nx10 PIM Yes
defaults write com.siemens.plm.nx10 JAVA_HOME /System/Library/Frameworks/JavaVM.framework/Versions/Current/Commands/java_home; export JAVA_HOME
```

Caveats

Mac OS X 10.8

If you are using Mac OS X version 10.8 (Mountain Lion), the minimum supported version for NX 10.0.3 is version 10.8.5. Apple's release of Mountain Lion (Mac OS X 10.8) no longer includes the X11 libraries required by NX.
Xquartz 2.7.5 and OpenMotif are required. You will be prompted to install Xquartz when attempting to run any X11 application for the first time and guided through the installation by those prompts. Check for Xquartz updates from the X11—Check for X11 Updates.... dialog box.

**Problem Displaying Text in UI**

On Mac OS version 10.9 (Mavericks) and Mac OS version 10.10 (Yosemite), there may be problems with displaying text in the user interface. You may initially encounter this problem with an error when you try to open a file from the File Open dialog box. The problems exist in both the XmTextField and TbxmActionListView. You can fix these problems by adding ":" to the end of their fontList definition in the Ugnx10 resource file.

*Ugnx10*XmTextField*fontList: -adobe-helvetica-medium-r-normal–12-120-75-75-p-*-iso8859-1:

*Ugnx10*TbxmActionListView*fontList: -adobe-helvetica-medium-r-normal–12-120-75-75-p-*-iso8859-1:

**Note**

You can locate them by searching for XmTextField and TbxmActionListView in your Ugnx10 file.

**CAE**

NX 10.0.3 on Mac OS X does not support any CAE functionality. CAE modules and specialized NX functions that depend on CAE are not supported.

**Plotting**

Plotting of high quality images using the **View**→**Visualization**→**High Quality Image** command does not work.

**Relations Browser**

The relations browser is not supported. When you choose **Assemblies**→**WAVE**→**Relations Browser**, the command does not work.

**Spreadsheet support**

NX 10.0.3 on Mac OS X does not support the use of any spreadsheet.

**Enabling the Alt key**

When you use NX, the Alt key can be very handy. The Mac OS does not automatically enable the Alt key for use with NX. You have to update the X server’s keyboard mapping.

**Redefine the key on the keyboard**

To enable the Alt key, you need to update the keyboard mapping to redefine the key labeled **alt/option**. Enter the following command in a Terminal window:

```
    defaults write org.x.X11 option_sends_alt -boolean true
```

The **alt/option** key now sends Alt_L and Alt_R instead of Mode_switch.
Linux graphics caveats

Some applications experience a severe X server crash with Red Hat 6.0 (and later) and SuSE 11.x. The crash of the server causes the user to exit the login session. When this occurs, the user must login again. This problem has only been seen on nVidia graphics boards. If you are using an older driver, the first recommendation is to try the latest graphics driver. If this problem is observed in other applications, the following workaround can be applied.

Note

Use this workaround only if you experience the problem, as it can cause a performance slowdown. To work around this problem, modify `/etc/X11/xorg.conf` and add the following line to the Device section for nVidia after the Driver line.

```
Option "UseCompositeWrapper" "true"
```

Thus, after the change, the device entry in `xorg.conf` might look like:

```
Section "Device"
 Identifier   "Videocard0"
 Driver       "nvidia"
 Option       "UseCompositeWrapper" "true"
EndSection
```

You must login as root in order to make this change. It is prudent to make a backup copy of `/etc/X11/xorg.conf` before making this change. Each time the nVidia driver (the same or a newer version) is installed, you need to take the above steps to ensure the Option line is included. In order for the change to take effect, you must restart the X server by either rebooting or pressing Ctrl+Alt+Backspace (if you are in a live X session).

Note

With some AMD configurations on Red Hat and SuSE, a different problem has been observed whose similarity with the problem seen with the nVidia configuration may cause you to believe it is the same problem. This problem causes NX and many X applications to fail with a segmentation violation or a memory fault at the start. However, this problem is likely due to the AMD graphics driver not being configured correctly. The simple solution to this problem is to do the following:

1. Login as root
2. Make a backup copy of `/etc/X11/xorg.conf`.
3. Remove `/etc/X11/xorg.conf`.
4. Regenerate a new `xorg.conf` by running the command:
   ```
   aticonfig --initial
   ```
5. Restart the X server.
**Supported hardware and graphics**

The list of currently supported hardware and graphics cards can be found on the GTAC support page Customer Support (GTAC) Web site at Hardware and Software Certification → Hardware (Graphics Card) Certifications. This opens a spreadsheet that has tabs for supported systems and graphics.
Initializing the JVM

In some cases, NX is not able to create the Java Virtual Machine (JVM) properly on Windows. The root cause in these scenarios is insufficient memory to start the JVM. In most cases of insufficient memory Java is able to report back an error code indicating this problem. However, in some cases Java reports a generic error message that NX then displays. The typical error message is:

Can’t initialize the Java Virtual Machine (JVM)

When running a Java application, such as the Wave Browser or Interactive Class Editor, NX may give an unexpected error due to this problem.

Starting in NX 8, if NX detects that there is not enough memory available for the JVM, an error message is given and information is provided in the syslog. The following is an example of the syslog information:

The JVM could not be created due to not enough memory.
The Java heap size must be contiguous and the largest contiguous block available is outputted below.
Windows largest block free

Maximum block 267Mb

Please note, this number is to be used as suggestion for setting the heap size. It is unlikely that you will be able to utilize the full amount.
If you need a heap size larger than what is possible you can try to use the /3GB switch or its equivalent, if available for the Operating System you are on.
Otherwise your other option is to use Remoting. Please consult the NX Open Programmer’s Guide for more information on this topic.

Reset the size of the Java heap

To remedy this problem, you can reset the size of the Java heap that NX uses. Choose File→Execute→Override Java Parameters to open the dialog box and set UGII_JVM_OPTIONS to the size of the Java heap. You can experiment with the size of heap that you need, but if the JVM is already started then you cannot change the UGII_JVM_OPTIONS setting.

It is recommended that you use both the –Xmx and –Xms options together. Both of these are needed as Java may determine default values for the heap size that are not possible with the machine’s current memory load. For example:

UGII_JVM_OPTIONS=–Xmx=50M –Xms=50M

When trying to determine the size of the heap, keep in mind that if the heap size is too small, a Java program you are trying to run may not run. This could be due to the amount of memory available on the machine, or due to multiple Java processes running. This can be the case with the Wave Browser where there is a client and server process.

Once you find a value that works, you can modify the UGII_JVM_OPTIONS value in the ugiie_env.dat file so you don’t have to reset it in the NX Open Java Parameters dialog box each time you start an NX session.
NX variables in the ugii_env.dat file

Standard and modified environment variables

The ugii_env.dat file contains the standard environment variables for NX. You can override these variables with the ugii_env.dat file. This file is essentially empty when delivered. You can define new values for the environment variables in this file and they take precedence over the values defined in the ugii_env_ug.dat file.

The ugii_env.dat file should be used to modify any standard NX environment variables or add new ones.

Both the ugii_env_ug.dat and ugii_env.dat files are located at <UGII_BASE_DIR>\ugii.

**Note**
You can make all, some, or none of the changes to the variables in the ugii_env_ug.dat file. However, it is recommended that you use the ugii_env.dat file to define all of the values in use at your site.

Using the ugii_env.dat file

The following apply when using the ugii_env.dat file:

- Define the variables before the #include statement.
- The first variable defined is used. If you have the variable defined twice in the file, only the first one is used.

**Note**
This also applies to the ugii_env_ug.dat file.

- You cannot have spaces in the variable names.

Designate a single ugii_env.dat file for all users

You can place the ugii_env.dat file in a central location for all users to access.

For each user, set the environment variable UGII_ENV_FILE to the location of the file. For example:

```
UGII_ENV_FILE=G:\common\version_env_vars.corp_standards
```

**Note**
The file can have any name but must be a fully qualified path.

Statements you can use in the ugii_env.dat file

The statements that you can use in the ugii_env.dat file are shown below with examples:

- `#if/#else/#endif`
  Used to check for specific conditions and then to define variables based on those conditions. Conditions that can be checked are:
FILE - Check for the existence of a file

```bash
#if FILE ${UGII_BASE_DIR}\UGII\html_files\start_${UGII_LANG}.html
UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_${UGII_LANG}.html
#else
UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_english.html
#endif
```

platform - Check for a specific platform. Possible values:

- x64wnt
- ix86wnt
- Lnx64
- macosx

```
#if Lnx64
UGII_CAM_THREAD_MILL=${UGII_CAM_THREAD_MILL_DIR}\thrm.so
#endif
```

$variable = “value” - Check for a specific value for a previously defined environment variable

```
#if $UGII_LANG = "simpl_chinese"
UGII_COUNTRY=prc
UGII_COUNTRY_TEMPLATES=${UGII_BASE_DIR}\localization\$UGII_COUNTRY\simpl_chinese
#endif
```

$variable != “value” - Check for a previously defined environment variable that does not have the specified value.

```
#if ${UGII_PACKAGE_DIRECTORY} != ""
#if FILE ${UGII_PACKAGE_DIRECTORY}\ugii_package_env.dat
#include ${UGII_PACKAGE_DIRECTORY}\ugii_package_env.dat
#endif
#endif
```

- #include

  Used to include a specified environment file at the current location

    #include ${UGII_PACKAGE_DIRECTORY}\ugii_package_env.dat

Browser requirements

Browser and plug-in requirements

The NX suite of documentation (Help, What's new Guide, and Release Notes) is Learning Advantage courses are provided in an HTML format that is displayed in your local Web browser.

The documentation requires a web server. You can install the Siemens PLM Documentation Server, which sets up a local web server on each workstation, or install the documentation into an existing company-wide server.

The latest versions of web browsers are recommended to comply with the latest browser security updates.
Windows browser support

- Internet Explorer
- Mozilla Firefox
- Google Chrome

Linux browser support

- Mozilla Firefox

If you have other Mozilla web browsers installed on your system, make sure either your default browser is set to the correct Firefox version, or the UGII_HTML_BROWSER environment variable in your ugii_env.dat file is set to the supported Firefox version.

Mac OS X browser support

- Safari
- Google Chrome

Downloading browsers

These browsers are free and can be downloaded from the following Web sites:

- Internet Explorer — http://www.microsoft.com
- Firefox — http://www.mozilla.org
- Safari — http://www.apple.com

Windows .chm files

Some parts of the Help are delivered in Microsoft Compiled Help format (.chm). Windows security enhancements prohibit opening .chm Help files across a network, so you must install those files on your computer. If you install .chm Help files on a server, you cannot read the Help across the network.

Flash required for videos

To watch videos and simulations, you must have the Adobe Flash Player version 10 or later installed as a plug-in to your browser. You can download the Flash Player (free) at the Adobe Flash Player site.

Adobe Acrobat Reader

Some portions of the Help may be delivered as PDF, which requires the Adobe Acrobat Reader. You can download the free reader from http://get.adobe.com/reader/.
Browser caveats

Browser caveats for Internet Explorer

IE9 compatibility view. The HTML Help is fully supported when launched with the http:// protocol or the file:// protocol. However, if you are viewing an older version of the Help from a local installation, such as D://, you may need to enable the Compatibility View. In IE 9, perform the following:


2. In the Compatibility View Settings dialog box, select Display all websites in Compatibility View.

Browser caveats for Firefox

- Mozilla recommends that you upgrade to the latest version of Firefox due to security issues surrounding Java. They do not recommend using older versions of Firefox. For more information, see http://support.mozilla.org/en-US/kb/latest-firefox-issues.

- The default behavior in Firefox 3.0.5 is for new pages to be opened in a new tab. This affects the behavior of the global search since new links will open in a tab instead of a new window. You can configure Firefox to open a new window instead of a new tab by selecting Tools→Options→Tabs.

- Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you want to launch from a UNC path (file://), Firefox has a default security setting that prevents the Help from launching correctly. To enable this, you need to change the value of the security.fileuri.strict_origin_policy preference:

  1. In the address bar, type about:config.

  2. In the Filter field, type security.fileuri. If the value of the security.fileuri.strict_origin_policy preference is set to TRUE, set the value to FALSE. Double-click on the value to toggle it.

  3. Restart the browser.

- If you are trying to open a .chm file that you have accessed from a web server (not from a local install), you may not be able to open the file as it is blocked. To unblock, right-click on the file and choose Properties, then select the unblock option.

Browser caveats for Chrome

Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you installed with the file:// protocol, you have to run Help from the command line. To fix this, see http://code.google.com/p/chromium/issues/detail?id=39767.
Licensing Caveats

General licensing caveats

License files and license server

The following are applicable to license files and the license server:

• Merging of license files is not supported.

Example

You can not merge a pre-TC 2007 MP3 or pre-NX 5 license file, which uses the uglmd license daemon, with a TC 2007 MP3, NX 5, or NX 6 license file, which uses the ugslmd daemon.

NX 10.0.3 requires and tests for the latest version of the ugslmd vendor daemon. This vendor daemon is supplied with NX 10.0.3 and must be installed and initiated prior to starting NX 10.0.3. If an older daemon is utilized, a generic NX License Error dialog box is displayed during start-up. In addition, the syslog will contain an error message that the daemon version is older than the client.

• The SPLM License server install requires that Java 1.5+ is installed on the system.

NX Borrowing is version specific

NX license borrowing is version specific due to dependencies within the third party licensing software used by Siemens PLM Software. To ensure that NX works on a borrowed license, you should always utilize the borrow tool supplied with that NX version. For example, a license borrowed using the NX 10 borrowing tool will work for NX 10 but cannot be used to run NX 9. In addition, you cannot borrow licenses for two NX versions simultaneously on the same workstation.

Licensing Guides

Refer to the NX 10 software DVD for the most recent version of the various licensing, administration and server installation guides. The licensing guides included in the NX 10 Help are outdated and should not be used.
Licensing caveats for Windows

The following caveats are applicable to Windows platforms only.

**License Option tool**

The **License Option** tool should only be used to borrow NX licenses, even though it may display other licenses. The **License Option** tool does not filter features in the license file that are of an earlier version than NX 10.0.3, such as Teamcenter lifecycle visualization, so these licenses are displayed in the tool. Attempting to borrow a license other than NX 10.0.3 causes an error in the **License Option** tool.
Licensing caveats for Linux

Additional software to support licensing

SuSE and Red Hat require the following to be installed:

- LSB 3.0
Licensing caveats for Mac OS X

License server preference settings

The license server used by NX is specified during NX installation, but it may be necessary to view or change the license server setting after installation. To do that, open a Terminal window and use the following commands.

• To read the current license setting:
  ```bash
defaults read /Library/Preferences/com.siemens.plm.nx10
```

This command will show the current setting. For example “SPLM_LICENSE_SERVER” = “28000@myserver.mycompany.com”

• To change the license setting:
  The following command will set the SPLM_LICENSE_SERVER preference to "myserver1":
  ```bash
defaults write /Library/Preferences/com.siemens.plm.nx9 SPLM_LICENSE_SERVER 28000@myserver1.mycompany.com
```

You may need to use “sudo” if the Preferences file is writeable only by an administrator. For example

```bash
sudo defaults write /Library/Preferences/com.siemens.plm.nx9 SPLM_LICENSE_SERVER 28000@myserver1.mycompany.com
```

You do not need to restart the machine after setting the NX preference.

License server naming on Mac OS X

Mac OS X is different from many other operating systems due to the fact that when the networking conditions change, the hostname of a Mac workstation will change.

For example, while on the network (&lt;mysite&gt;.com), the hostname is mac1.&lt;mysite&gt;.com. While disconnected from all networks, the hostname changes to mac1.local. FLEXnet relies on the use of the hostname to locate the server so this hostname change causes the license server daemons to lose communication and prevents the client application from connecting to the license server. The result is an NX startup error caused by the inability to get a license.

This condition usually occurs when a single user on a laptop installs the license server and NX on the same laptop.

Use one of the following recommendations to help prevent or resolve this situation:

• Install a license server on a workstation or system that has a stable domain. It is recommended that a central license server be used for all client applications.

• Use the local IP address (127.0.0.1) for the hostname as follows.
  Change the file from:
  ```bash
  SERVER Yourhostname COMPOSITE=a1234567890b 28000
  ```
  To:
When asked for the license server value during the client application install, provide the following:

28000@127.0.0.1

- Request a standalone non-served license file. These license files do not need a license server but simply need to have the application point to a file. These license files are ideal for a user with only one seat of an application that is to be installed on a laptop. Contact your customer service representative for a standalone license file.

**Common licensing tool on Mac OS X**

The Common Licensing Tool (CLT) for Mac OS X is a licensing utility that enables the user to select bundles and borrow licenses.

**Bundle selection**

The interface to the Bundle Selection in the CLT for Mac is essentially the same as in the License Options application on Windows.

In order to select a bundle, you highlight the bundle in the Available Bundle list and click the Add button, or double click the selected item. The item is moved to the Selected Bundle list.

To remove an item from the Selected Bundle list and return it to the Available Bundle list, you can highlight the bundle you wish to return to the Available Bundle list and click the Remove button. Alternatively, you can double click the bundle to remove it from the Selected Bundle list.

No bundles are actually applied until you click OK. When you click OK, the modifications to the selected bundle list are written to a file in the user’s home directory, called splms_cl.reg.

The CLT for Mac allows for product-specification in the bundle settings. Thus, the name of the key for the bundle value is <PRODUCT>_BUNDLES, where <PRODUCT> is the product in question (such as NX, in which case the key would be NX_BUNDLES).

**Borrowing**

Borrowing with the CLT is similar to borrowing with License Options for Windows. To borrow a license feature or features, you select the features that you want and then choose the return date and time. Then you click the Borrow License(s) button. Finally, to perform the actual communication with the license server and borrow the selected items, click OK.

To return a borrowed license, you select the item you want to return, click the Return License(s) button, and then click OK.

The Reset button will cause all Return Dates to go back to the original state they were in when you initially launched the tool. Thus, items that were not borrowed will have their return dates cleared, and any items that had the return date changed or cleared will be reset to their original value when the tool was launched.
# Product compatibility - supported version combinations

## Teamcenter and NX

The following table lists which version combinations of Teamcenter and NX are supported.

<table>
<thead>
<tr>
<th>Teamcenter UA</th>
<th>NX 7.5</th>
<th>NX 8.0.x</th>
<th>NX 8.5</th>
<th>NX 8.5.x</th>
<th>NX 9</th>
<th>NX 9.0.x</th>
<th>NX 10</th>
<th>NX 10.0.x</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.1</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9.1</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

(1) Only Teamcenter UA 2007.2.0.2 or higher.

(2) Only Teamcenter UA 8.1.0.4 or higher.

(3) NX 7.5.4 MP2 or higher.

(4) NX 7.5.5 MP2 or higher.

(5) Compatible with Teamcenter UA 8.3.0.2 or higher. Recommended Teamcenter UA 8.3.3.4 or higher.

(6) NX 8.0.2 or higher.

(7) Only Teamcenter UA 8.3.3.5 or higher.

(8) Only Teamcenter UA 9.1.2 or higher.

(9) Only Teamcenter UA 8.3.3.6 or higher.
(10) Only Teamcenter UA 10.0.0.1 or higher.

(11) NX 8.5.2 MP1 or higher with Teamcenter UA 10.1.0.1 or higher.

(12) Only Teamcenter UA 9.1.2.4 or higher.

(13) Only Teamcenter UA 10.1.0.1 or higher.

(14) For NX 9.0.2, Active Workspace 2.1. For NX 9.0.3, Active Workspace 2.2.

(15) Only Teamcenter UA 10.1.2.2 or higher.

(16) Active Workspace 2.2.

(17) For NX 10.0.1, Active Workspace 2.2, 2.3, and 2.4.
For NX 10.0.2, Active Workspace 2.3 and 2.4.
For NX 10.0.3, Active Workspace 2.4 and 3.0.

**Note**

For information on version compatibility for Teamcenter and Teamcenter lifecycle visualization, see the Teamcenter documentation.
## NX compatibility with Spreadsheet

<table>
<thead>
<tr>
<th>NX version</th>
<th>Platform</th>
<th>Operating System</th>
<th>Windows</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Spreadsheet Software version</td>
<td>8 64-bit Pro &amp; Enterprise</td>
<td>MS Excel 2013 (32-bit)</td>
<td>AIS XESS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8 64-bit Pro &amp; Enterprise</td>
<td>MS Excel 2010 (32-bit)</td>
<td>Certified &amp; supported</td>
</tr>
<tr>
<td>Windows</td>
<td></td>
<td>7 64-bit Pro &amp; Enterprise</td>
<td>MS Excel 2007 (32-bit)</td>
<td>Certified &amp; supported</td>
</tr>
<tr>
<td></td>
<td>Linux</td>
<td>Suse Enterprise</td>
<td>MS Excel 2003 (32-bit)</td>
<td>Not supported</td>
</tr>
<tr>
<td>Linux</td>
<td>SuSE</td>
<td>11 SP1</td>
<td></td>
<td>Certified &amp; supported</td>
</tr>
<tr>
<td>NX 10.0.x</td>
<td>Red Hat</td>
<td>Red Hat Enterprise V6</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note**

- The NX spreadsheet interface is not supported on the MAC platform in NX 10.0.x.
- The 64-bit versions of Microsoft Excel are not yet supported by NX. The 32-bit version of Excel is installed by default on the Windows 64-bit Operating Systems.
- Microsoft Starter Edition is not supported by NX due to lack of support for Add-in's, Macro's, Math and Equation Editing.
- If you open a part with Excel 2003 data or older and then save the spreadsheet, NX updates the data to Excel 2007 or later (to the Excel version currently running with NX).
- If you launch a spreadsheet command such as Spreadsheet or Part Family on a system having Excel 2003 or older version as the default spreadsheet application, NX displays an error message and does not proceed with the launched command.
# NX applications unsupported on specific platforms

The applications listed are not supported on the specified platforms.

<table>
<thead>
<tr>
<th>Application</th>
<th>Functionality</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway</td>
<td>File Print</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>File Open of SolidWorks files</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Advanced Studio Rendering Style Mode</td>
<td></td>
</tr>
<tr>
<td>Plotting</td>
<td>Plotting of high quality images using the <code>View → Visualization → High Quality Image</code> command</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Manufacturing Milling</td>
<td>Siemens 840D virtual machine tool controller (VNCK)</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>Manufacturing Wizard Builder (part of Simulation Process Studio)</td>
<td></td>
</tr>
<tr>
<td>Design Simulation (CAE)</td>
<td>All</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td></td>
<td>Advanced Simulation and Design Simulation Abaqus OBD result file reading</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Motion Simulation Mechatronics co-simulation with RecurDyn solver</td>
<td></td>
</tr>
<tr>
<td>Teamcenter Integration</td>
<td>Launching NX from Active Workspace web client</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Human Modeling</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>PCB Exchange</td>
<td>Automatic creation of ESC solution</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td></td>
<td>CR5000 pcb files Import / Export / Compare (PCB Exchange for Zuken limitation)</td>
<td></td>
</tr>
<tr>
<td>Mechatronics Concept Designer</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>CMM Inspection Programming</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Simple NX Application Programming (SNAP)</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
</tbody>
</table>
Support for touch enabled devices

In NX 10, you can interact and manipulate 3D models and control the overall user interface using touch screen and stylus. The support for touch enabled hardware follows a slightly different support model than what is provided through the NX certification program. We have tested NX on a number of Windows based touch screen laptops, monitors, and tablets. However, support for these devices and other comparable systems is limited as they are not true workstations and do not qualify for our full certification program. Support for these devices is limited as follows:

- Graphics performance issues are not supported as most of these devices do not offer the level of driver support available on workstations.
- Graphics quality and display issues are not supported unless they can be duplicated on a certified workstation.
- Any issue determined to be caused by the graphics driver is not supported.
- Performance issues with NX are not supported on these systems unless reproducible on certified workstations.

Caveats aside, we have tested and used for development a variety of touch based systems from HP, Dell, Microsoft, and others and have found them acceptable for general usage of NX.

Additional Notes

- NX supports touch devices on both Windows 7 and Windows 8 operating system.
- Only stylus configurations support pre-highlighting. The most commonly used devices supporting stylus are the Surface Pros and the Perceptive Pixel configurations.
Chapter 2: Fundamentals
Product Notes

Retirement of Classic Toolbar User Interface from the Windows platform

The choice for a Classic Toolbar user interface on Windows will be removed in NX 11. In order to ease your transition from toolbars to ribbon, NX 9 and NX 10 give you a choice of Ribbon Bar or Classic Toolbar mode for your user interface. This choice will be removed in NX 11 and the Ribbon Bar will be the only user interface choice on Windows. The Ribbon Bar was implemented in NX 9 and provides access to more commands than the Advanced role in Classic Toolbar mode with a larger graphics window. And it does all this with logical groupings, informative text and a mixture of icon sizes. In addition to these traditional aspects of the Ribbon Bar, the NX ribbon is fully customizable and contains NX-specific extensions such as border bars. The result is a more organized user interface with the richness of Advanced and the discoverability of Essentials.

For instructions on how to migrate from Classic interface to Ribbon bar interface, see NX Ribbon-Customization and Transition.
**Caveats**

**File New dialog not localized**

The **File New** dialog Tab names and template names will display in English no matter what runtime language is set by the UGII_LANG variable.

**Bookmarks**

If you create a bookmark file with Ray Traced Studio mode enabled, when the bookmark is applied Ray Traced Studio mode will not be in effect.

If you create a bookmark file when displaying a View Section with clipping disabled, when the bookmark is applied the section may be incorrectly clipped.

If you try to apply a bookmark file when

1. the bookmark file is not for the current displayed part and
2. the number of views in the layout at the time when the bookmark file was created is not the same as the number of views in the current displayed part

then the number of views in the layout may be wrong after the bookmark file is applied. Applying the same bookmark file a second time corrects the number of views.

**Pixel Widths settings**

If you open a part that was last saved in any release before NX 8.5 and then use the **Edit Object Display** command to modify the width of an object, the pixel width applied to the object might appear thinner than you expect.

If the display of line width is unsatisfactory, use the **Pixel Widths** settings to change the pixel width assigned to the line.

* You can change **Pixel Widths** settings of the currently displayed part on the **Line** tab of the **Visualization Preferences** dialog box.

* To change **Pixel Widths** settings of all pre-NX 8.5 parts and of new parts created using the **Blank** template, change the default **Pixel Widths** settings on the **Line** tab in **Customer Defaults** dialog box→**Gateway**→**Visualization**.

**Using Ray Traced Studio on NVIDIA devices**

To render images using the **Ray Traced Studio** command with acceleration in NX, on NVIDIA devices, you need to install the **UGPHOTO** directory on a path without a space. You also need to reset the following environment variables accordingly:

* UGII_LI_TOP
* UGII_LI_LAYLA_DIR
* UGII_RENDER_ARTISTIC_DIR
* UGII_SHOWROOM_DATA_DIR
* UGII_CANNED_MATERIAL_DIR
• UGII_HDR_IMAGE_DIR
• UGII_ENV_IMAGE_DIR
• UGII_SYSTEM_SCENE_DATA_DIR
• UGII_TRUESHADING_DIR

Please see ugii_env_wnt.dat for more information.

For a standard installation in the C:\program files(x86)\... location, you may not get acceleration when you use the Ray Traced Studio command. The workaround is to move UGPHOTO to a path without a space and reset the relevant UGII_environment variables.

**Example**

If you move UGPHOTO to C:\workdir\UGPHOTO, then you need to set the following environment variables as shown:

• UGII_LI_TOP=C:\workdir\UGPHOTO\ray_traced_studio
• UGII_LI_LAYLA_DIR=C:\workdir\UGPHOTO
• UGII_RENDERS_ARTISTIC_DIR=C:\workdir\UGPHOTO\artistic_render
• UGII_SHOWROOM_DATA_DIR=C:\workdir\UGPHOTO\ug_environment
• UGII_CANNED_MATERIAL_DIR=C:\workdir\UGPHOTO\ug_canned_mattex
• UGII_HDR_IMAGE_DIR=C:\workdir\UGPHOTO\hdr_images
• UGII_ENV_IMAGE_DIR=C:\workdir\UGPHOTO\env_images
• UGII_SYSTEM_SCENE_DATA_DIR=C:\workdir\UGPHOTO\system_scene_data_dir
• UGII_TRUESHADING_DIR=C:\workdir\UGPHOTO\true_shading

**Interoperation request in Windows**

In the Windows operating system, when NX receives an interoperation request, the NX application will not be raised in front of other running applications.

Interoperation requests occur when you send a part from Teamcenter to NX or when you double-click a part in the Windows Explorer. Newly started NX sessions would still appear at the front.

**Using Teamcenter as the issue site for NX Issue Management**

When you use NX Issue Management, you can specify Teamcenter as the issue site only when Teamcenter Issue Manager is deployed via Teamcenter Environment Manager at the server side. NX displays an error message if it cannot connect to Teamcenter Issue Manager. For more information, refer to the Teamcenter Environment Manager Help.
Chapter 3: CAD

Modeling

Product Notes

Trim Sheet

In addition to receiving functional enhancements in NX 10 the Trimmed Sheet command has been renamed to Trim Sheet. Legacy Trimmed Sheet features will be renamed to Trim Sheet. Custom programs that use the feature name Trimmed Sheet will need to be updated to Trim Sheet.

Spline (to be retired)

The legacy Spline command is to be retired in a future release of NX and is now hidden. It is recommended that you use the Studio Spline command instead. Until it is retired you have the option to bring the legacy Spline command back to NX under its new name, Spline (to be retired), using the Customize command.

Thicken gash removal

The Remove Gashes option in the Thicken command has been renamed to Improve Gash Topology to Enable Thickening.
Caveats

Assigning materials to NX parts

Beginning in Teamcenter 10.1, the Teamcenter Reuse Library is enhanced to let you define materials and make them available. However, you cannot yet assign materials to NX parts using this method. If you want to assign materials to NX parts such as part family members, you can use your user or site material libraries.

Facet Modeling

The following Facet Modeling commands handle simple data cases only:

• Extrude Facet Body
• Merge Disjoint Facet Bodies
• Merge Overlapping Facet Bodies
• Merge Touching Facet Bodies

Support for more complex data cases will be available in a future release of NX.

Drafting

Product Notes

Dragging while creating dimensions

Enhancements to the Drafting and PMI user interface give you the ability to relocate a dimension, and other annotations, while creating the dimension. You can move the dimension, or other annotation, after it is initially placed and no other objects have been selected for dimensioning.

Creating 2D centerlines between concentric arcs

When you create a centerline between two arcs with coincident center points, the result varies depending on the relative position of the arcs:

• If the longer arc extends beyond the complete length of the shorter arc, initial centerline extension points are limited to the ends of the longer arc.
• If one arc extends beyond a partial length of the other arc, initial centerline extension points are limited to the extreme end of each arc.

• If the arc lengths do not overlap, a full circular centerline results.
Caveats

Error when referencing an expression in a note

You may encounter an internal error if you do the following:

1. While in the Drafting application, open the Expression dialog box.
2. In the Settings group, set the Show Groups option.
3. Create and save an expression.
4. Reference the expression in a drafting note.
5. Open the Expression dialog box and, in the Settings group, clear the Show Groups option.

This is a known issue and is fixed in NX 10.0.3, MP1.
Documentation Notes

Populate Title Block command in a drawing template

The Populate Title Block command is not available from the shortcut menu when working in a drawing template. A drawing template is created by using the Mark as Template command.

If you want to use the Populate Title Block command to edit the contents of a title block in a drawing template, you must specifically choose Drafting Tools tab→Drawing Format→Populate Title Block

Or you can double-click the title block to open the Edit Definition dialog box, and then click the Edit Table button to edit the contents of the title block.

Assemblies

Product Notes

Update Structure on Expand

The Update Structure on Expand customer default check box is now selected by default. This ensures that you see an up-to-date assembly structure when you expand unloaded subassembly nodes in the Assembly Navigator.

Note

The update that occurs when you expand an unloaded subassembly with Update Structure on Expand selected can cause a small delay. You may therefore notice that some assemblies need a little more time to expand than in previous NX releases, when the Update Structure on Expand customer default was not selected. If you clear the Update Structure on Expand check box, the performance may improve; however, you then risk displaying an out-of-date or incorrectly-configured assembly structure if the expanded subassembly is not loaded.

Using Make Unique when the original part has unsaved changes

Underlying parts must always be in sync with parts in Teamcenter. Therefore, you cannot use the Make Unique command to create a unique component from a part that has unsaved changes. You will receive a message that gives you the following choices:

Yes — Save Saves the changes to the original part without canceling the Make Unique command. You can now create the unique component.

Cancel Cancels the Make Unique command. The unsaved changes in the original part are not affected; you can save, modify, or discard them as necessary.

A third choice, No — Discard Changes, which let you discard the changes in the original part and create a unique component that included the changes, is no longer available. A unique component must be in sync to the original component when it is created. After you create the unique component, you can modify it.
**Note**

This change applies to NX 8.0.3 as well as NX 8.5 and subsequent releases.
Caveats

Move Component

When the setting of your Move Component Scope customer default is Anywhere in Assembly, NX ignores this setting if the displayed part or any of its subassemblies contain any component patterns. When you move components in this situation, the Move Component command behaves as though the Move Component Scope customer default is set to Work Part Only.

Sequencing

When a subassembly of the displayed part contains a component pattern, inserting a motion step in your sequence that affects a member of the component pattern may cause incorrect movement of the following:

• Members of the component pattern.
• Components directly constrained to the pattern members.
• Components indirectly constrained to the pattern members.

When component patterns are present only in the displayed part, the Insert Motion command works correctly.

Component Patterns

The following caveats apply to component patterns, which replaced component arrays in NX 9.0.

Position overrides

When the position of component pattern members are overridden in a higher-level assembly, edits to their positions in the higher-level assembly may result in the components being incorrectly positioned. This can occur when the assembly that contains the pattern is not positioned at the origin of its parent assembly.

Selecting geometry for the pattern direction

When you create or edit component patterns, you can define a direction by selecting geometry only when the selected geometry is in either the work part or in a component that is an immediate child of the work part.

In NX 9.0.1 and later releases, you can also use geometry selected from components that are further down the assembly structure of the work part. However, the direction definition is not associative unless the selected geometry is in the work part or one of its immediate children.

Performance of very large component patterns

NX may be slow when creating very large component patterns, typically patterns with thousands of members. In most cases, you can improve the performance by ensuring that the Dynamic Positioning check box on the Pattern Component dialog box is not selected when you create the pattern.

Reordering in the Assembly Navigator

When the active order in the Assembly Navigator is the Alphanumeric order or the Alphabetic order, you can use the Reorder Components dialog box only when the navigator is sorted by the first column. If the navigator is sorted by any other column while the Alphanumeric order or the
Alphabetic order is active, you can reorder components only by dragging. This creates a new user-defined order.

This limitation exists only with the Alphanumeric order and the Alphabetic order. When any other order is active, you can reorder components using the Reorder Components dialog box regardless of which column is used to sort the navigator.

Visual Reporting

Caveats

Density reports

When you generate a report using the Body Density report property, it is possible for the report to return a value of 0.0000. This can occur because the default unit for Body Density is kg/mm³, and the body density of most materials is less than 0.00001 kg/mm³.

There are two options that can be used to work around the display issue:

- Select Preferences→User Interface to change the General→Displayed Decimal Places→Dialog Box setting from 4 to 9.
- Select Analysis→Units Custom→Units Manager to change the Measure→Mass Density setting from kg/mm³ to kg/m³.

For example, the density of a steel component could be displayed as 0.000007831 kg/mm³ if the Displayed Decimal Places preference is set to 9. If the Mass Density is set to kg/m³, the density would be displayed as 7831.

Data Reuse

Product Notes

Index Search Server Installation

The Reuse Library index search makes use of the Solr search engine. You will need to install SPLMDOCSERVER to start the Solr search engine. This will run as a service, Siemens PLM Documentation Server, which will be automatically started when the system reboots.

You can find the SPLMDOCSERVER and installation guide from the NX DVD.
Sheet Metal

Caveats

Exporting multi-segment lofted flanges to Trumpf GEO format

Flat Pattern of a model that contains multi-segment lofted flanges cannot be exported to Trumpf GEO format.

Mirroring lofted flange feature with dependent features

Mirroring lofted flanges that have dependent features may give incorrect results for legacy (pre-NX 9) sheet metal parts. You must recreate the Lofted Flange feature in NX 9 or later release.

Unite in Sheet Metal

When you unite Sheet Metal bodies:

• If the target and tool bodies are not positioned correctly, the united Sheet Metal body may not be a valid Sheet Metal body.

• The tool body must not contain unfolded bends.

• If you unite bodies that consist of Sheet Metal and Advanced Sheet Metal features, the united body may not support subsequent Sheet Metal operations.

Three Bend Corner

• The Blend Miter option may not work for Three Bend Corner features created across bends where the central bend does not touch one of the side bends. In other cases some extra edges around the cutout may be incorrectly blended.

• Any gussets on any of the input bends will be lost when you create the Three Bend Corner feature.

Pattern Face in Sheet Metal

The Pattern Face command is a Modeling command that is included in the Sheet Metal application for the convenience of users. It should be used for performance reasons in typical patterning operations where the required result is a large number of pattern objects. For example, patterning a large number of holes, cutouts, dimples, or louvers, on a tab face.

However it is not recommended that it be used in all cases as a substitute for the regular patterning commands in Sheet Metal, because it can cause downstream problems with various sheet metal features such as unbend, rebend, flat solid, copy, paste, and mirror. In these cases, while it may work, it can produce different downstream behavior. For example, a series of flanges that are patterned using the Pattern Face command will unbend and rebend together.

Bend Taper

You cannot use the Bend Taper command to create tapers on bends of advanced flanges and joggles.
Documentation note

Bridge Bend enhancements

If the sheet metal bodies intersect, NX trims the sheet metal bodies and joins them with a bend.

Example

Type = Fold Transition, and Width Option = Full Start Edge.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start edge</td>
</tr>
<tr>
<td>2</td>
<td>End edge</td>
</tr>
</tbody>
</table>

Creating transitions between intersecting sheet metal bodies

In the example, the Width option must be set to Full Start Edge.

Bridge Bend dialog box

The Start and End Parameters Equal check box is available when Type is set to Z or U Transition.

Routing

Caveats

Opening pre-NX 10 parts in NX 10

Opening pre-NX 10 parts might take longer when you open the part for the first time in NX 10.

Upgrade Stocks command

When using the Upgrade Stocks command on a part that uses Stock As Components and that has multiple levels of Routing assemblies, we recommend that you select the Work Part and Loaded Children Parts check box.

Color bleeding in harness displays

If the color bleeds through in the display of harnesses, use the Refinement Factor visualization preference to correct the display. The factor you must set varies depending on the part that is open.

In the Visualization Preferences dialog box→Faceting tab→Part Settings group, use the:

- Shaded Views subgroup→Refinement Factor option to adjust the display in a shaded view.
• **Advanced Visualization Views** subgroup→**Refinement Factor** option to adjust the display in advanced studio views.

**Teamcenter Classification**

The Teamcenter Classification plug-in is now obsolete. You can use the out-of-the-box support for classification by setting the Teamcenter classification options in the **Part Library** customer defaults.

**Tip**

To find a customer default, choose **File** tab→**Utilities**→**Customer Defaults**, and click **Find Default**.

You can use the Reuse Library for classification without setting up additional plug-ins.
Documentation Notes

Structure of a PTB file

The topic *Structure of a PTB file* erroneously states that NX uses the descriptor characteristics in the list of table columns in a PTB file to search for parts in the *Routing Reuse Search* dialog box. In reality, NX only displays the characteristics in the *Routing Reuse Search* dialog box. The switch /HIDE indicates that you do not want NX to show the characteristic in the *Routing Reuse Search* dialog box during part placement.

Note that the destination characteristics defined under specific disciplines in the APV file are used when you search for parts. This is not necessarily the same as what is displayed.

Unify Path enhancement

In previous releases, NX did not unify paths when direct mount parts or eccentric segments were a part of your selection. Parts that were placed using the *Instance Name Lookup* command and which were part of a run were ignored when you used the *Unify Path* command.

In NX 9.0.2 and later, in addition to the conditions mentioned above, NX does not unify a path that has an eccentric reducer part or any other routing part which has the *NX_BLOCK_UNIFY* attribute set to *TRUE* in the respective PTB file.

Parts which are placed using the *Instance Name Lookup* command are now ignored when you use the *Unify Path* command, even when the parts are not part of a run.
Product Notes

Automatic fix constraint on Stock Offset Ports

In NX 9.0.2 and higher, NX adds an automatic fix constraint to every Stock Offset Port component to keep the component from moving when you connect a segment to the offset port.

This constraint is called Offset Constraint in Assembly Navigator and Constraint Navigator. If you change the name, NX reverts to the original name when the automatic fix constraint is recreated.

If you suppress the constraint, the component is free to move till you unsuppress the constraint.

If you add a new fix constraint, NX deletes the automatic fix constraint. If you delete the fix constraint that you added, NX again creates an automatic fix constraint.

You cannot move a Stock Offset Port component while editing an existing constraint using the Assembly Constraints dialog box. You can move a Stock Offset Port component while creating a new constraint using the Assembly Constraints dialog box. You can move or transform a Stock Offset Port component using the Move Component or Transform Path command if the only fix constraint on the component is the automatic fix constraint.

In case of conflicts with other constraints, NX displays a warning. In order to resolve such conflicts, you can remove or suppress the constraints that you have created or you can suppress the automatic fix constraint.

Installing standard parts to Classification in Teamcenter Engineering TC9.1

You can install standard parts to Classification in Teamcenter Engineering TC 9.1 by using the Classification Install for Part Library tool provided in the following folder:

UGII_BASE_DIR\ugroute_mech\classification_tool

PMI

Product Notes

Dragging while creating dimensions

Enhancements to the Drafting and PMI user interface give you the ability to relocate a dimension, and other annotations, while creating the dimension. You can move the dimension, or other annotation, after it is initially placed and no other objects have been selected for dimensioning.

PCB Exchange

Caveats

Flat Solid workflow

The import and export of ECAD models in their bend state only works when the board is a solid body. If the board is an assembly component this workflow does not work.
Chapter 4: CAM

Manufacturing Product Notes

Manufacturing Product Notes

The Manufacturing product notes describe product changes that are not included in the What’s New in NX documentation.
CAM Early Adopter program

Some of the new NX CAM features are available only upon request through the CAM Early Adopter Program. In order to learn more about these pre-release features, please contact GTAC. GTAC will forward your request to the appropriate development contact.
Tool path and template changes

Tool path changes

A general reminder: There are ongoing changes in the processors to fix problems, add enhancements, and improve reliability. In many cases, you may see some differences between the new path and the old path when you generate an operation from a previous release. If you rely on automatic methods, these changes should be acceptable. The end result of the new path should be comparable to, or better than, the previous path.

Template updates in maintenance releases (MR)

Previous maintenance releases did not require changes to the provided templates, and the templates were not updated in these releases. Current maintenance releases contain significant enhancements that often require updates to the provided templates. When there are updated templates in a maintenance release, NX places them in an update folder in the MACH folder structure. The new Use Latest Updated Templates customer default controls where NX looks for templates, and is on by default.

When the Use Latest Updated Templates customer default is selected, native NX looks for templates in the update folder first (1). If the update folder does not contain the required template, NX then looks in the folder where the main release templates are stored. The main release templates are stored in the location specified by the cam_resource_dir environment variable, and by default, this location is MACH/resource/template_part (2).

- MACH
  - resource
    - template_part 2 Location for main release template files
  - updates
    - template_part 1 Location for maintenance release template files

If you do not customize your templates, you do not need to do anything differently. Native NX will automatically use the correct templates.

If you use customized templates in native NX:

1. Save them in a different location from the templates provided with the main release.
2. Modify the cam_resource_dir environment variable to point to their location.
3. Turn off the Use Latest Updated Templates customer default so that NX looks for your templates in the correct location.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find Default.

If you use Teamcenter Integration for NX, the Teamcenter administrator must do the following to import the maintenance release templates:
1. Copy the templates from the `updates\template_part` folder to the `resource\template_part` folder.

2. Run the `tcin_cam_template_setup.bat` script.

**Merging customized templates**

You can merge your customized templates with the templates included in this release in the following ways:

- Start with the new default templates and apply your customizations. This is *highly recommended* to ensure you receive all the PR fixes.
- Re-file your customized templates in the new release, review the changes listed for the release, and implement the applicable ones in your templates. This method is not recommended, because you will not receive the PR fixes.

**Template parts updated for NX 10.0.3**

There is a new `work_instruction` template part that is not in the template sets.

The first time you add a work instruction type operation, you must browse to `mach\resource\template_part\[units]\work_instruction.prt`.

The following template parts have an updated version in NX 10.0.3:

- `hole_making`
- `mill_planar`
- `mill_contour`
- `mill_multi_axis`
- `mill_multi_blade`
- `DieMold_Exp`
- `Machinery_Exp`
- `library_dialogs`

**Template part changes for NX 10.0.3**

<table>
<thead>
<tr>
<th>Operations</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><code>hole_making</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• There is a new <code>BACK_COUNTER_SINKING</code> operation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Geometry</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><code>mill_contour</code>, <code>mill_planar</code>, <code>mill_multi-axis</code>, <code>mill_multi_blade</code>, <code>library_dialogs</code>, <code>DieMold_Exp</code>, and <code>Machinery_Exp</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The <code>Tool Axis</code> option is now available by default in all <code>MCS_MILL</code> dialog boxes, and its value is not changed.</td>
</tr>
</tbody>
</table>
Tools

library_dialogs
- There are new IA and TD parameters for the tap tool.

hole_making
- There is a new BACK_COUNTERSINK tool class.

Template parts updated for NX 10.0.2

The following template parts have an updated version in NX 10.0.2:
- hole_making
- Machinery_Express
- Machinery_Exp

Template part changes for NX 10.0.2

Operations

hole_making
- There is a new DEEP_HOLE_DRILLING template. This is a customized drilling template.
- The Lowest Safe Z value has changed to 2.5 mm or 0.1 inches for all drilling and hole milling operations.

Programs

Machinery_Express and Machinery_Exp
- The program object now includes a Description field.

Template parts updated for NX 10.0.1

NX 10.0.1 includes updates from NX 9.0.3 MP1 and MP2

The following template parts have an updated version in NX 10.0.1:
- hole_making
- mill_planar
- mill_contour
- mill_multi_axis
- mill_multi_blade
- mill_rotary
- MillTurn_Express
- library_dialogs
**Template part changes for NX 10.0.1**

### Operations

#### hole_making

There are two new operations:

- radial_groove_milling
- sequential_drilling

In the **HOLE_MILLING** template, **start_diameter** is set to 0.0.

#### mill_planar

- The template value for **Cutting Parameters**→**Connection**→**Across Voids** is changed from **Follow** to **Cut**.

#### mill_contour

**Flow Cut** operation:

- **Cut Regions** selection is added to the *Geometry* group.

**Flow Cut Reference Tool** operation:

- When the **Steep Cut Pattern** option is set to **Zlevel Zig**, NX sets the new **Steep Overlap Value** option to 10% of the tool diameter.

**Cavity Mill** operation:

- When the **Cut Pattern** option is set to **Follow Periphery**, NX sets the **Pattern Direction** option to the new **Automatic** setting.

**Zlevel** operations:

- **Non Cutting Moves** dialog box→**Transfer/Rapid** tab→**Between Regions** and **Within Regions** groups:

  If **Transfer Type** is set to **Direct/Previous Plane backup**, the **Apply Safety Clearance to Direct** check box is selected.

All the operations shown:
Operations

- Non Cutting Moves dialog box→Smoothing tab→Engage/Retract/Stepovers group:
  When you select the Override with Smooth Connections check box, the default Tolerance is set to From Cutting.

mill_multi_axis

All the operations shown:

- Non Cutting Moves dialog box→Smoothing tab→Engage/Retract/Stepovers group:
  When you select the Override with Smooth Connections check box, the default Tolerance is set to From Cutting.

mill_multi_blade

All Multi blade operations:

- The Blade Edge option is set to No Curling by default, and the Extension value is set to 0.

mill_rotary

- Rotary Floor operation:
  - Non Cutting Moves dialog box→Smoothing tab→Engage/Retract/Stepovers group:
    When you select the Override with Smooth Connections check box, the default Tolerance is set to From Cutting.
### Tools
- In the Tap tool, there are new parameters IA and TD.
- In library_dialogs, the customizable item User Parameters is added to every tool.
- In hole_making, system tracking points for chamfering are added to the SPOT_DRILL, COUNTERSINK, and CHAMFER_MILL tools.

### Programs
- In OPTIMIZED_NC, Feature Sequencing and Non-Cutting Moves are added.

### Methods
- In MillTurn_Express, in the Method objects, the Stock group is added to the dialog box.
Preliminary Post Configurator documentation

Preliminary documentation for the Post Configurator is available on the GTAC site:

https://support.industrysoftware.automation.siemens.com/general/nx.shtml

On the NX Documentation page, select the NX 10 tab and click the Post Configurator help link.
Preliminary Robotic Machining documentation

Preliminary documentation for Robotic Machining is available on the GTAC site:

https://support.industrysoftware.automation.siemens.com/general/nx.shtml

On the NX Documentation page, select the NX 10 tab and click the Robotic Machining help link.
General changes

Paste with Reference enhancements

The Paste with Reference command now supports wave links and the new manual drilling operations.

Exporting tools as part files

Beginning in NX 10.0.1, you can create a new tool part file that contains solid bodies from a parametric tool definition. The part file contains a separate solid revolved feature for the flute, neck, shank, and holder definitions. This provides the functionality previously available by accessing the temporary tool in the Assembly Navigator.

To create the part file, in the Machine Tool view of the Operation Navigator, right-click a single parametrically defined tool and choose Object—Export Part. NX saves the tool as a single part file with the default name [tool name].prt.

Note

- This functionality is available only in native NX.
- A Modeling license is not required.
- Wave linking is not available. The solid features are based on tool parameters, and are not associative.

2D Dynamic collision display when verifying a tool path

In previous releases, rapid tool motions through the Part, Blank or IPW were displayed in the red gouge color as material removed. In the current release, the material removal from these tool motions is not displayed, so you will not see these collisions. To check for collisions, do one of the following:

- Click List after the simulation stops.
Click **Collision Settings**. In the **Collision Settings** dialog box, select the **Pause on Collision** check box to stop the visualization when a collision occurs. This option does not work if you step through the operation.

**User Defined Operation and API Enhancements**

The **User Defined Operation** API now has the ability to:

- Use the 3D milling IPW from a previous operation as the blank.
- Write level markers to the tool path. In verify, a tool path will have the ability to display one level at a time, just like a Cavity Milling operation.

**Machine Tool changes**

The standard machine tools supplied with NX have revised postprocessors and kinematics models. Review all existing Manufacturing setups which use a standard machine tool from a release prior to NX 8. If necessary, retrieve the machine tool again.
On-machine probing

Probing teach mode

The mom event output for probing teach mode operations has changed to align the output with other operation types. The following coordinate outputs are available within probing sub operations:

- **mom_probe_center_pos** contains the coordinates of the center of the probe tip.
- **mom_pos** now contains the coordinates of the active tracking point, which coincides with the center of the probe tip. **mom_pos** and **mom_probe_center_pos** contain the same output.
- **mom_probe_contact_pos** contains the coordinates of the contact point between the probe tip and the part or tool.

To support existing post processors, you can change the output with the following environment variable setting:

UGII_CAM_PROBING_LOCATION_OUTPUT = 1

This sets the **mom_pos** values for the probing sub operations to the **mom_probe_contacts_pos** values.
Feature-based Machining (FBM)

Feature teaching no longer supports the **Inferred** CSYS subtype.
Manufacturing critical maintenance and retirement notices

Manufacturing Wizard Builder

The Manufacturing Wizard Builder is on critical maintenance. It is a plug-in for the Process Studio Author (PSTUDIO) application, which is no longer being developed. The 32 bit version is included in the NX installation, and there is no plan to discontinue this.

The location in the Windows start menu has changed. Choose Start→All Programs→Siemens NX 9.0→Manufacturing→Process Studio Author

There are no plans to discontinue CAM Wizards, which are xml files based on our block based UI architecture.

Point To Point planned retirement from all platforms

Point To Point is in critical maintenance, and its templates will be hidden from the default system in the next main release.

The following operations and geometry objects in the current Drill template are affected:

- DRILL_GEOM
- SPOT_FACING
- SPOT_DRILLING
- DRILLING
- PECK_DRILLING
- BREAKCHIP_DRILLING
- BORING
- REAMING
- COUNTERBORING
- COUNTERSINKING
- TAPPING

The manual holemaking module introduced for NX 9 should be used instead of the Point To Point module. The new method to manually drill holes will fully replace the Point To Point module over the course of the next two to three releases.

The migration of Point To Point operations is not committed. However, existing Point To Point operations remain functional and editable.
Integrated Simulation and Verification (ISV)

ISV Simulation

• If the spindle speed is zero for an operation, then no material is removed from the IPW.

• Internal and external simulations now use the same geometry definitions for the part and the workpiece. You must assign the geometry to the related kinematic model components, which are classified as _PART and _WORKPIECE.

  If a legacy part does not have geometry defined in the kinematics model, NX uses the geometry defined in the Operation Navigator for internal simulations.

• Tool path based simulation is not supported for mill-turn machine tools even if they are single channel single setup.

ISV Simulation examples

The number of simulation examples using the MTD technology is reduced, and the functionality is reduced. The examples that support MTD are sim05, sim11, and sim13. These examples are in the folder Legacy_MTD within mach\samples\nc_simulation_samples.

The CAM setup example part file sim15_millturn_sinumerik_mm_setup.prt is no longer supported and maintained. It will be removed from the install at NX 11.

Virtual NC Kernel (VNCK)

To run an external file machine tool simulation properly, all channels of the machine tool model that can be assigned a main program must exist in the kinematics model before you start VNCK.

Manufacturing caveats

General caveats

Work Instructions

Do not include Documentation operations as the target for the following commands, as unexpected results may occur.

• Parallel Generate

• Replay

• Object Transform

• Simulate

• Gouge Check

• Verify
Shop Documentation

Each time you create Shop Documentation, NX generates facet bodies. To reduce the size of your part file, delete the facet bodies before saving it.

Command Finder: Faceting

Tilt Tool Axis

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shortest 2D distance to curve</td>
<td>Use the 3D shortest distance option.</td>
</tr>
<tr>
<td>For longer tool paths, the shortest distance calculation can become unsynchronized.</td>
<td></td>
</tr>
<tr>
<td>The tilted tool path may have non cutting moves with lifts in regions where they are not needed, and the moves can cause gouges.</td>
<td>None</td>
</tr>
</tbody>
</table>

IPW

A Generic Motion (GMC) operation does not change the machine mode state of the IPW. Adding a Machine Control subop with a Set Modes event at the beginning of the GMC operation does not change the machine mode state of the IPW. The previous machine mode, either milling or turning, remains active.

If the preceding operation does not have the required machine mode, you must add an operation with the required machine mode before the Generic Motion operation. For example, if the Generic Motion operation is for turning, add a turning operation. The new operation must generate tool path, but does not need to cut material.

Note

This is not a limitation in ISV when you use the CSE driver. The machine state is defined by the workpiece spindle setting, which is either turning or milling.

Manufacturing documentation caveats

Multi blade documentation caveat

The following information is currently missing from the released documentation.

Multi blade recommendations for roughing and hub finishing

When roughing between the blades or finishing the hub, the tool path should have good tangential extensions and even stepovers at the leading and trailing edges of the blades.

Roughing or hub finishing with small amounts of stock

When roughing, the tool path is often more efficient if it does not curl around the blade. The roughing pass does not need to contour the leading and trailing edges because the remaining material does not matter. Additional contouring would waste machining time.
The following example shows the difference in material remaining between a pass with curling (1) and without curling (2).

For most parts with a pre-machined blank that has a small amount of stock, the Blade Edge option No Curling is the most appropriate and efficient. NX automatically stops following the blade geometry when the tool reaches the edge area. At one side, NX limits the curling to the radial direction. On the other side, NX adds a small tangential extension to ensure complete machining. Both sides end at the same height.

Blade Edge = No Curling

Roughing with large amounts of stock

When there is a larger amount of stock, use the Along Blade Direction option and add radial extensions to completely machine the part.

The roughing tool path should look something like the following example.

Blade Edge = Along Blade Direction
Tangential Extension = 0 % Tool
Radial Extension = 100 % Tool
Hub finishing with large amounts of stock

When there is a larger amount of stock, and you finish the hub while roughing, or when you need to finish a dedicated hub area in front of the blades, allow the tool to curl slightly around the blade before adding a radial extension. The tool path should look similar to the following example.

Blade Edge = Along Part Axis
Distance = 10 % Tool
Tangential Extension = 0 % Tool
Radial Extension = 100 % Tool

Make sure that the distance to the path of the neighboring pocket is similar to the stepover as shown in the following example.

Where do I find it?

<table>
<thead>
<tr>
<th>Application</th>
<th>Manufacturing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prerequisite</td>
<td>Multi Blade operation</td>
</tr>
</tbody>
</table>
| Location in dialog box | [Multi blade operation] dialog box→Drive Method group→edit drive method
| | Blade rough, hub finish operations:
| | Multi Blade Rough Drive Method or Hub Finish Drive Method dialog box→Leading Edge group |
Milling caveats

Area milling drive method operations using trim boundaries

The **Contact** tool position option for trim boundaries trims the tool path to the tool contact of the trim boundary. However, with the **Extend at Edges** cutting parameters option selected, the tool is moved past the contact by the specified extend distance. In the past trim boundaries were not changed by the **Extend at Edges** option.

[Area milling drive method operation]→**Cutting Parameters**→**Strategy** tab→**Extend Path** group

Curve/Point drive method — Offset Left option

The loops caused by offsetting a concave curve or curves are not trimmed.

Rotary Floor milling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Min. Lead Angle does not influence the tool path.</td>
<td>None</td>
</tr>
<tr>
<td>When you use sheet geometry to define a concave floor, sometimes the default material side is wrong and no tool path is produced.</td>
<td>1. In the <strong>Rotary Floor Finish Drive Method</strong> dialog box, in the <strong>Drive Geometry</strong> group, click <strong>Flip Material</strong>&lt;br&gt;2. Generate the operation.</td>
</tr>
<tr>
<td>The cutting parameters option <strong>Roll Tool Over Edges</strong> does not affect the tool path.</td>
<td>None. This parameter will be removed.</td>
</tr>
</tbody>
</table>

Non Cutting Moves

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z-Level operations with cutter compensation set may have the wrong engage or retract motions when the open area engage type, or the retract type, is also set to one of the following options:</td>
<td>Examine the generated engage and retract moves. If they are not acceptable, consider using a different open engage type or retract type.</td>
</tr>
<tr>
<td>• Arc – Parallel to Tool Axis</td>
<td></td>
</tr>
<tr>
<td>• Arc – Normal to Tool Axis</td>
<td></td>
</tr>
<tr>
<td>• Arc – Normal to Part</td>
<td></td>
</tr>
</tbody>
</table>
### Cavity Milling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is significant slowdown when the new <strong>Cut Below Overhanging Blank</strong> option is turned off.</td>
<td>None. The processor must do more calculations to detect and avoid the unproductive cuts. In applicable cases, there is a significant saving in machining time, and the extra generation time is well spent.</td>
</tr>
</tbody>
</table>

| Cut Below Overhanging Blank | If the part does not have areas with overhanging blank, do not clear the check box. |

### Fixed-axis contouring cut area selection

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you edit a cut area created with the selection method set to <strong>Edge Bounded Region</strong>, the seed face and the bounding edges display in the selection color and are difficult to identify.</td>
<td>You can use the alternate selection color to identify the seed face and bounding edges.</td>
</tr>
</tbody>
</table>

| | To see the seed face, click **Select Bounding Edges**. |
| | To see the bounding edges, click **Select Seed Face**. |

**Tip**

If you still cannot see the bounding edges, increase the line width display.

- **Menu**→**Preferences**→**Visualization**→**Visualization Preferences** dialog box→**Line** tab→**Part Settings** group→**Show Widths**→set **Width Scale** to **Maximum**

### Area Milling cut regions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Divide</strong> command</td>
<td>The <strong>Divide</strong> command is generally successful when splitting localized areas, such as spikes, along the periphery of a single region.</td>
</tr>
</tbody>
</table>

- The **Divide** command may fail when splitting the region across multiple features, such as holes and pockets, contained within a single region. |
## Floor Wall Milling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut regions can collapse for the following cut patterns if the <strong>Tool Overhang</strong> value is less than 100%:</td>
<td>Change the <strong>Tool Overhang</strong> value.</td>
</tr>
<tr>
<td>• <strong>Follow Part</strong></td>
<td>Change the <strong>Tool Overhang</strong> value.</td>
</tr>
<tr>
<td>• <strong>Follow Periphery</strong></td>
<td><strong>Floor Wall Milling</strong> dialog box→<strong>Path Settings</strong> group→<strong>Cutting Parameters</strong> dialog box→<strong>Cut Regions</strong> group.</td>
</tr>
<tr>
<td>• <strong>Trochoidal</strong></td>
<td>• Reducing the <strong>Merge Distance</strong> value may help.</td>
</tr>
<tr>
<td><strong>NX</strong> does not consider the part geometry between features when merging the tool path. This can result in the following:</td>
<td><strong>Floor Wall Milling</strong> dialog box→<strong>Path Settings</strong> group→<strong>Cutting Parameters</strong> dialog box→<strong>Cut Regions</strong> group.</td>
</tr>
<tr>
<td>• Cut levels where features that should not have merged interfere with each other.</td>
<td>• Alternatively, create separate operations for each feature.</td>
</tr>
<tr>
<td>• Wrong sequencing.</td>
<td>None</td>
</tr>
<tr>
<td>When features are merged, the merged shapes are sometimes larger than they should be. As a result, the cut areas and completed tool path are also larger than they should be.</td>
<td>None</td>
</tr>
<tr>
<td><strong>NX</strong> does not always merge cut areas when the <strong>Blank</strong> option is set to <strong>Blank Geometry</strong> or <strong>3D IPW</strong>.</td>
<td>None</td>
</tr>
<tr>
<td><strong>NX</strong> should ignore gaps smaller than the <strong>Merge Distance</strong> value to create a continuous tool path.</td>
<td>None</td>
</tr>
<tr>
<td>The <strong>Part Outline</strong> and <strong>Blank Outline</strong> options for <strong>Extend Floor To</strong> always creates a single feature, even if the final cut areas are not continuous. This can result in the following:</td>
<td>Create separate operations for each feature.</td>
</tr>
<tr>
<td>• Cut levels where features that should not have merged interfere with each other. (Similar to the <strong>Merge</strong> issue.)</td>
<td>Create separate operations for each feature.</td>
</tr>
<tr>
<td>• No sequencing.</td>
<td>None</td>
</tr>
<tr>
<td>Region sequencing is only done between features. It is not done between regions within features. This can result in an overall sequence that is not optimal. This is especially noticeable in operations with a single feature, such as when you extend the tool path to the part or blank outline.</td>
<td>None</td>
</tr>
<tr>
<td>Problem</td>
<td>Workaround</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
</tr>
</tbody>
</table>
| In some cases, wall extensions can trim off too much or too little. | Use the following options for the best results:  
  **Cut Region Containment** = Floor  
  **Exact Positioning** = off  
 Use the following options only when needed:  
  **Cut Region Containment** = Wall  
  **Exact Positioning** = on |
| If the IPW material is wider between two cut levels than it is at the respective cut levels, Floor Wall Milling does not always identify the excess IPW material. As a result, the operation may not cut all the material. | Use more cut levels. |
| The **Exact Positioning** option does not consider the precise tool shape when analyzing blank/IPW geometry. This can make Floor/Wall Milling identify too much IPW material, which can result in air cutting. | None |

**Flow Cut**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bull nose reference tool performance may be slow.</td>
<td>None</td>
</tr>
<tr>
<td>When the reference tool radius is approximately the same size as the fillets on the part, as in near-fit conditions, inconsistent and/or extra tool path may be produced.</td>
<td>Increase the overlap distance and/or tighten the operation tolerances to help reduce occurrences.</td>
</tr>
<tr>
<td>Using the <strong>Minimum Cut Length</strong> option can remove small cut-motions in steep corners, especially when the remaining uncut material is narrow.</td>
<td>In the <strong>Flow Cut Drive Method</strong> dialog box, reduce <strong>Minimum Cut Length</strong> to a small value or 0.0 to ensure that cut-motions are not removed.</td>
</tr>
</tbody>
</table>
Contour Profile variable axis profiling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contour Profile</strong> operations only compensate for diminishing walls when the wall is in contact with the floor.</td>
<td>None</td>
</tr>
<tr>
<td>Supported cases:</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="" /></td>
<td></td>
</tr>
<tr>
<td>Not supported cases:</td>
<td></td>
</tr>
<tr>
<td><img src="image2.png" alt="" /></td>
<td></td>
</tr>
<tr>
<td>Multiple offset passes that push the tool entirely above the wall height significantly increase generation time.</td>
<td>To reduce generation time, limit the number of offsets so that they do not exceed the wall height.</td>
</tr>
</tbody>
</table>
Hole machining caveats

Tapping operations

Drilling and Tapping are distinct operation subtypes. Although tapping cycles are available in the Drilling operation dialog box, we recommend that you do not use a Drilling operation for tapping. The tapping cycles will be removed from the Drilling operation in a future release.

In a Tapping operation, you can set feature geometry parameters, such as pitch, that output the required mom variables for tapping. If you use one of the tapping cycles in a Drilling operation:

- The operation will not contain the necessary feature geometry parameters and in-process feature volumes for tapping.
- You will have the legacy Point to Point output where the pitch is driven by feed rate.

Deep drilling limitation for partial intersections

When you drill through a cross hole, or partial intersection, NX now crosses the intersection in a single motion using the Step Over feed rate. Partial intersections are intersections that are smaller than 3 times the tool diameter, regardless of the angle of the crossing hole. NX applies this limit when Intersection Strategy is set to IPW or Part and IPW.

All other intersections are considered full intersections. NX crosses full intersections in 3 motions using the First Cut, Cross Over, and Last Cut feed rates.
**ISV caveats**

**Visualize 2D Dynamic**

- If blank geometry is not defined, you must click Step Forward twice before NX asks for blank geometry.

- On the Linux and Mac OS X platforms, the 2D Dynamic tab may not be active.
  
  The 8-bit PseudoColor visual graphics driver mode is not supported. As a work around, change the graphics X server settings. For example:

  NVidia Quadro and FX graphics drivers

  In the XF86Config file, in the Device section, set CIOverlay to TRUE.

**Simulation**

- In certain cases the reported minimum distance of a clearance violation is not the closest distance.

- Selecting a location on the tool path is now supported in ISV for both CSE-based simulation and tool path simulation. Selecting tool path segments involving cycles, such as drilling cycles, may not work in some cases.

- Collision checking between the IPW and active non-spinning tools is performed with the spinning geometry of the cutting and non-cutting parts of the tool, which can lead to false reports of collisions. In the following graphic, the green outline indicates the geometry that is actually used for collision checking.

  ![Collision Checking Graphic](image)

- For a collision between the IPW and the cutting segment of a non-spinning active tool, the following false error message is displayed:

  Tool and IPW are colliding in Rapid Mode
Positional ISV — Show Machine Axis Positions dialog box

When the setup has a multi-function machine and you use the dynamic manipulator to change the tool axis for a fixed-axis operation, NX does not update the **Show Machine Axis Positions** dialog box. To avoid confusion, use the **Show Machine Axis Positions** customer default to suppress the dialog box.

1. Choose **File** tab→**Utilities**→**Customer Defaults**.

2. In the **Customer Defaults** dialog box, choose **Manufacturing**→**User Interface**.

3. Click the **Dialog Boxes** tab, and in the **Visibility** group, clear the **Show Machine Axis Positions Dialog** check box.

**Save as Component**

When you verify multiple operations, and use the **Save as Component** IPW option, NX saves a separate component part file for each operation.
Turning caveats

In Turning, you cannot select an in-process workpiece from an external source to define the blank.
## Post Configurator caveats

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heidenhain MillTurn support</td>
<td>None</td>
</tr>
<tr>
<td>MillTurn operations are not post processed correctly for Heidenhain controllers when you create the post processor with Post Configurator.</td>
<td>None</td>
</tr>
<tr>
<td>Custom Message Leader inheritance status</td>
<td>A workaround is not required as this does not impact post processor functionality.</td>
</tr>
</tbody>
</table>
| The inheritance status of the setting of Messages and Listing→Messages→Custom Message Leader will show User defined even if the value was never changed by the user. | For the Sinumerik S840D, add the following line to the postprocessor’s main DEF file if needed:  
$POST_LIB_CURRENT_MACH_DIR/Controller/ctrl_s840d_base.cdl  
For the Sinumerik S828D, add the following line to the postprocessor’s main DEF file if needed:  
$POST_LIB_CURRENT_MACH_DIR/Controller/ctrl_s828d_base.cdl |
<p>| When you create a new post processor, a CDL is not added automatically to the main DEF file. Therefore the CYCLE832 UDE and extra drilling UDEs for PTP operations are not available for Sinumerik controllers. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
</table>
| Post Library registry location  
You cannot change the post processor template library location using the Database customer default setting. | None |

**Tip**
To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find Default.
Chapter 5: CAE

Advanced Simulation

Product Notes

Improved handling of coordinate systems during manual meshing

When you use the following manual element creation commands, NX now copies both the associated displacement and nodal coordinate systems from the nodes on the source elements to the nodes on the newly created elements:

- Element Copy and Translate
- Element Reflect and Translate
- Element Project and Translate

In previous releases, you had to manually assign displacement and nodal coordinate systems to the newly created elements.

JT results support

This release includes enhancements to JT file creation from NX Post Processing. JT files that you create in NX 10 are compatible with the JT V10 format, and you can view the file in Teamcenter Visualization. A graphics card supporting OpenGL 3.2 or greater is required to visualize CAE data in JT V10 files in Teamcenter Visualization 11.1.
Caveats

Boundary layer meshing

The Auto Fix Failed Elements option in the 3D Tetrahedral Mesh dialog box does not work for tetrahedral meshes created with the Boundary Layer type in the Mesh Control dialog box.

Load Recipe Manager

- Currently, the Load Recipes Manager is capable of handling up to 10,000 functions. In future releases, the Load Recipes Manager will be enhanced to handle more functions.
- Vector format data is not yet supported in the Load Recipes Manager.
- If you create a solution using the New Solution from Load Recipe command and manually delete all the solution steps, the Update Solution from Load Recipe will not work. In this case, you have to create a new solution from the load recipe. This issue will be addressed in NX 11.

Functions for expressions

Arguments for several fluid-thermal functions for defining expressions will change in the NX 11 release. You will need to redefine any expressions, loads, or constraints that use these functions when you migrate your model into NX 11.

The functions whose arguments will change are:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VA(i)</td>
<td>Returns the convecting area of a void.</td>
</tr>
<tr>
<td>VP(i)</td>
<td>Returns the maximum pressure of the void.</td>
</tr>
<tr>
<td>VSV(i)</td>
<td>Returns the maximum swirl velocity of the void.</td>
</tr>
<tr>
<td>VT(i)</td>
<td>Returns the maximum temperature of the void.</td>
</tr>
</tbody>
</table>

XY Function Navigator

For both Structural Modal Contribution and Acoustic Modal Contributions results, the XY Function Navigator currently displays incorrect mode numbers adjacent to the listed modal results. For example, in the graphic below, the mode numbers are reported as mode 1 and 2, when the user requested that the software calculate modes 3 and 4.

This issue has been fixed in the NX 11 release.
Post Processing

- For NX Nastran laminate composite results, NX Post-processing takes the in-plane and inter-laminar stresses together to calculate the ply-stress invariants. Consequently, the values reported by NX Post-processing are different from the values found reported in the NX Nastran results file (.f06).

- The material orientation vector display is incorrect for the following types of NX Nastran and MSC Nastran elements:
  - CQUAD4
  - CQUAD8
  - CTRAX3
  - CTRAX6

- You cannot use the **Result Probe** command to display results on models that contain super elements.

- The **Result Probe** command does not display correct results on models that contain fields defined with local coordinate systems.

Materials

In NX 7.5, the default material library changed from an NX-specific .dat format to a MatML XML format. Starting with NX 11, the legacy material library .dat format will no longer be supported.

Abaqus environment

Issues occur when you import an Abaqus input file that has multiple surface pairs defined with the same *CONTACT PAIR keyword. Currently, if all surfaces that comprise the master surfaces or the slave surfaces do not have the same entity type, NX fails to import the input file. For example, you cannot import a master surface in which some surfaces are defined with nodes and some are defined with elements. Likewise, you cannot import a slave surface if some of the surfaces are defined with element faces or edges and others are defined with nodes. However, NX can import models in which the master and slave surfaces are comprised of surfaces that are defined with different entity types. For example, you can define all the surfaces that comprise the master surfaces with nodes and define all the surfaces that comprise the slave surfaces with elements.

ANSYS environment

- In the **Region** dialog box, if you select **Yes** from the **Use ESURF** list, you must also select **Flexible** from the **Type** list in the new **Region Type and Pilot Node** group of options. Rigid body type regions are only supported in ANSYS when you select **No** from the **Use ESURF** list. Currently, if you select **No** from the **Use ESURF** list and then select **Yes**, the **Select Master Grid Point** option is visible. This option should only be visible when you select **No** from the **Use ESURF** list. However, NX correctly writes out the ANSYS input file without the pilot node.

- If you use the **Pressure** command to apply a spatially varying field-based load to a surface, the software uses the ANSYS **CMBLOCK** command to group the pressures and labels of the element faces when you export or solve your model. Sometimes, this grouping process is incorrect and
may lead to incorrect analysis results in the NX 10 and NX 10.0.1 releases. To avoid this issue, clear the Create ANSYS component (CM) for similar loads check box in either the Export Simulation or the Advanced Solver Options dialog box.

- When you export or solve a Coupled-Fields Thermal-Structural solution that contains a Structural Contact simulation object, KEYOPT(1) is always set to 2 by mistake in the ANSYS input file. This means that ANSYS only considers thermal contact during the solve. To have ANSYS consider both structural and thermal effects on the SOLID226/227 elements, KEYOPT(1) must be set to 1. To work around this issue, select the Write, Edit & Solve Input File option from the Submit list in the Solve dialog box, Then, correct the value of KEYOPT(1) so that it is set to 1. For example:

  Change: ET,31,CONTA174, 2,3,,0,3,0
  to: ET,31,CONTA174, 1,3,,0,3,0.

**LS-DYNA environment**

- Material *MAT_116 (*MAT_COMPOSITE_LAYUP) is not supported for import.

- Material *MAT_054-055 (*MAT_ENHANCED_COMPOSITE_DAMAGE) is now supported for import and export. However, during import, NX incorrectly maps *MAT_054-055 in the user interface to *MAT_COMPOSITE_LAYUP (the default).

- You can now define the stress-strain curve for LS-DYNA materials. NX exports this data as the LS-DYNA keyword *MAT_PIECEWISE_LINEAR_PLASTICITY or as *MAT_024. However, the NX Material library does not provide the correct plastic strain value for the LS-DYNA solver at the starting point of the curve. In LS-DYNA, the curve must start at a non-zero value. To work around this issue, you must manually correct the starting point value. Additionally:
  - Temperature-dependent stress-strain data is currently unsupported. Although you can define it in NX, only the first temperature value is exported to your LS-DYNA input file.
  - The *MAT_PIECEWISE_LINEAR_PLASTICITY keyword is not yet supported for import. It will be supported in a future release.

**NX Multiphysics environment**

The inherited concentrated mass material is not used by the thermal solver.

**Samcef environment**

- Currently, you cannot use the Solid Properties Check command to compute the inertial properties of a mesh when Samcef is the specified solver.

- If you use an orientation node to define a beam cross section orientation, the beam offset values are incorrect in the Samcef input file.

- In an assembly FEM, if two component FEM files use the same ply IDs in their laminate definitions, the Model Setup Check command does not currently flag this as an error. Samcef does not allow two component FEMs to use the same ply ID. Currently, the ply data from one component FEM overwrites the data from the other component FEM in the Samcef input file.
NX Thermal and Flow, NX Space Systems Thermal, and NX Electronic Systems Cooling

- Free molecular heating is not working when you specify a mass density that varies with altitude.

- Beginning in NX 10, the **Radiative Heating** simulation object no longer supports spatial distribution of the power when the **Heat Load Type** list is set to **Total Power**.

- The import of an XML input file containing simulation objects, constraints, or loads defined by a dimensionless spatial distribution, 4D field (heterogeneous or table of fields), or specific symbolic expression (for example a plugin function that takes a named point as an argument) is not supported.

- For two-phase, immiscible fluid simulations, the fractional step scheme is not supported. You must use the fully coupled pressure-velocity scheme.

- Surface tension is not supported in immiscible fluid mixtures.

- The import of CGNS files is not working. The nodes are imported but the elements are missing.

- Beginning in NX 9, to use the following commands and features, you must have a license of the NX Advanced Fluid Modeling product:
  - **Surface Wrap Body** command
  - **Local Resolution Constraint** command
  - **Contact Prevention Constraint** command
  - **Fluid Domain** simulation object
  - CGNS export of your fluid model

- NX 9.0.x and NX 10.0.x cannot use NX 8.5.x or older parallel configuration XML files. When you open an old XML file in the Parallel Configuration Tool, only the filename is preserved. You must make all appropriate selections before saving the file to use it for parallel processing.

- The inherited concentrated mass material is not used by the thermal solver.

**Geometry optimization**

Beginning in NX 10, **Altair HyperOpt** is no longer available as an optimization type in NX. All geometry optimization is now performed with the **NX Optimizer**. Parts from previous releases with optimization solutions that used **Altair HyperOpt** are automatically converted to use the **NX Optimizer** instead.

Additionally, the Knowledge Fusion (KF) class `ug_hyperopt_optimize` has been retired. This class no longer appears in the BOM and is no longer supported. Part conversion of KF objects is not supported. Therefore, if you have legacy parts that contain instances of `ug_hyperopt_optimize`, you must replace these objects with KF class `ug_optimize` instead.

**NX Response Simulation**

The software allows you to create an **Enforced Motion** load in a **Static Load Set**. However, Response Simulation does not recognize that enforced motion load when you create an event.
Durability

- Non-English characters in material names cause Durability solver errors.
- Durability only uses table fields for S-N and E-N curves.
- **Durability Wizard** does not work starting in NX 10.

NX Laminate Composites

- Round-tripping an H5 file can result in orphan elements, even if the mesh is unchanged.
- The reference plane location is not correctly displayed in the **View Laminate** dialog box in NX Post-processing.
- In the context of an assembly FEM, do not set **Stacking Recipe** to **Inherited from Layup** in the **Laminate Modeler** dialog box to define the material orientation method for component FEMs.
Chapter 6: Programming Tools

The Release Notes for Programming Tools are available only with the installed NX Help documentation. After you install the documentation, you can access the information from any of the following locations.

• From the Start menu on your system, choose:
  o All Programs→Siemens NX 10.0→Documentation→NX Release Notes.
  o All Programs→Siemens NX 10.0→Release Information→NX Release Notes.

• Within NX, choose:
  o File tab→Help→Release Notes.
  o Menu→Help→Release Notes.
Chapter 7: Inspection and validation

Check-Mate and Requirements Validation

Caveats

Validation rules

Validation rules do not yet recognize unset part attributes.

CMM Inspection Programming

CMM release notes

VALISYS critical maintenance and retirement notice

The VALISYS application is in critical maintenance, and becomes unsupported July 21, 2016. The NX CMM Inspection Programming application should be used instead of VALISYS Programming and CMM Inspection Execution should be used instead of NX-Inspect.
Caveats

Renaming or deleting the SENSORS group

In the Inspection Navigator, do not delete or rename the SENSORS group as this may cause machine simulations within the Inspection Path dialog box to fail.
Chapter 8:  Tooling Design
Mold Wizard simulation enhancements (10.0.3)

There are four major simulation improvements in NX10.0.3.

1. Mold Open Angle and Ejection Start Angle

Two new options are available in the Preprocess Motion dialog box for simulation hydraulic motion.
- To define simulated hydraulic motion within a mold, use the Mold Open Angle option.
- To define the simulated hydraulic motion before the part is ejected, use the Ejection Start Angle option.

For example:
If you set Mold Open Angle to 10, the cavity starts to open at the 10 degree point of the 0-360 range of the simulation.

If you set Ejection Start Angle to 5, the ejector plate begins to move at the 5 degree point when the mold is fully open.

2. Hydraulic Definition

When you use the Define Slide command, you can set parameters defined under Type→Cushioned Programming for drivers that must be retracted before the mold opens, or for specifying a motion before the part is ejected. The following options are available:

- Before Mold Open: Reads the predefined hydraulic angle and retracts the defined hydraulics before opening the mold.
- Before Ejection: Reads the predefined hydraulic angle and retracts the defined hydraulics before the part is ejected.
- None: This is not a hydraulic motion.

3. Slide and lifter recognition

NX can automatically recognize slides and lifters that are added to a mold assembly. You must assign component definitions before you add the component to the mold assembly. The component definitions for slides and lifters are:

- MW_COMPONENT_NAME=SLIDE
- MW_COMPONENT_NAME=LIFTER

To open the attribute definitions map, click the Edit Configure Data File icon in the Mount Components group in the Preprocess Motion dialog box.

Note

To use default slide and lifter definitions OOTB, download the MW engineering data from the GTAC website.
4. Refine Collision Result

When you simulate mold and component movements, NX may report hard collisions for some components. The **Refine Result** option generates a more comprehensive list that reduces the time needed to identify hard collisions.
Mold flow analysis

The mold flow analysis tools, Easy Fill, and Easy Fill advanced are available for download on the GTAC ftp site: https://download.industrysoftware.automation.siemens.com/unigraphics/moldwizard/. After you log on to the ftp site, at the moldwizard page, select the nx10 folder, and download the following files:

- EasyFillAdvancednx10.0_data_V1.README.TXT
- EasyFillAdvancednx10.0_data_V1.zip

The README.TXT file supplies information on how and where to install the Easy Fill product.

If you have a Mold Wizard or Molded Part Validation license, you can access the following basic functions:

- Select one gate location
- Obtain analysis results for Melt Front Time

To access more advanced functions, you need an Easy Fill or Easy Fill Advanced license.
Tooling Design documentation

The Tooling Design documentation that appeared in the NX 10.0 release notes is now in the NX 10.0.1 online help.
Chapter 9: Data translation
Product Notes

Updates in the default tessUG.config JT configuration file

The value of the `JtFileFormat` option in the default JT configuration file is changed from `JtFileFormat = "9"` to `JtFileFormat = "10"`.

If you use the default JT configuration file, NX to JT translator produces version 10 JT files. To generate version 9.5 JT files from NX10, we recommend you to set the `JtFileFormat` option to "9" in the JT configuration file that you use to produce the JT files.

Note

- To view version 10 JT files, you must use Teamcenter Visualization 10.1 or later.

- To import version 10 JT files in NX, you must use NX 9 and later versions. If you use older version of NX, we recommend you to produce version 9.5 JT files.

- To import version 10 JT files in SolidEdge, you must use Solid Edge ST7 or later versions. If you use older version of SolidEdge, we recommend you to produce version 9.5 JT files.

- If you intend to import version 10 JT files to any other CAD software other than NX, Teamcenter Visualization, or SolidEdge, we recommend you to check the respective CAD system end user documentation for its compatibility with the version 10 JT file. If the software does not support version 10 JT files, we recommend you to produce version 9.5 JT files.

CATIA V5 translator product notes

You can now:

- Import CATIA V5-6R2014 SP1 files to NX.

- Export NX files to CATIA V5 R14 or R19 files.
Caveats

Internationalization

File import or export by the following translators may not work if you set the NX temporary directory `UGII_TMP_DIR` to a folder containing non-locale characters.

- DXF/DWG
- IGES
- STEP
- 2D Exchange (export only)

**DXF/DWG translator caveats**

- If you export a locked 2D component, the latest component definition is exported to the DXF/DWG file.
  
  You can avoid this by creating a new component definition. To do this, right-click the 2D component and choose **Make Unique**.

- 2D components with color override are exported as per the colors set in the component definition.

**DXF/DWG – Dimension export caveats**

These caveats are applicable when you export a file using the **3D** option in the **AutoCAD DXF/DWG Export Wizard** dialog box.

- Dimensions associated with external references are exported as non-associative dimensions to the DXF/DWG file.

- NX Radius dimensions associated with ellipse or spline object are translated as AutoCAD block reference.

- The dimension associated between NX sheet object and View port object may be translated as overridden text of AutoCAD dimension.

- Narrow dimensions are exported as non-associative dimensions to the DXF/DWG file.

- Perpendicular, Chamfer, and Thickness dimensions are exported as block reference to the DXF/DWG file.

- Angular dimensions created with vector option are exported as block reference to the DXF/DWG file.

- Dimension with fits tolerance having fit tolerance style other than **Fit Symbol** is exported as block reference in AutoCAD.

- Dimension text location may not match with NX for the dimensions created with oriented text.

**DXF/DWG – MText import caveats**

You cannot import:
2D Exchange caveats

- Object attributes with title longer than 50 characters or string value longer than 132 characters are not exported to 2D parts.

2D Exchange – Dimension export caveats

These caveats are applicable for both, when you export a file using the **NX Part file** option in the **2D Exchange Options** dialog box or when you export a file using the **2D** option in the **AutoCAD DXF/DWG Export Wizard** dialog box.

Following dimensions are exported with the Override Dimension Text:

- Feature Parameter Dimensions
- True Length Dimensions
- Dimensions in scaled view and output set to **Modeling** (applies only when you export a file using the **NX Part file** option in the **2D Exchange Options** dialog box)
- Dimensions associated to:
  - Drafting Intersection point
  - Offset center point
  - Section line (in scaled view)
- The dimensions where associated object type changes in the flattened part. For example, circle projected as line.

Following Data will be exported as grouped geometry in the 2D part file and as a block in the DXF or DWG file.

- Linear and Radial callouts
- Retained dimensions
- Component level dimensions and PMI dimensions
- Inherited ordinate PMI dimensions
- Dual dimension in scaled views and output set to **Modeling**.
- Dimension with hole and shaft tolerance in scaled views and output set to **Modeling**.
- Dimensions associated with:
  - Blanked objects
  - 3D and Symmetric centerlines
- Faces
- Two object intersection (applies to ordinate dimension only)
- Target Points
  - Dimension created in plane other than view plane.

**CATIA V5 translator caveats**

- You cannot translate the CATIA V5 R7 and earlier version of files.
- You cannot translate standard and user defined attributes.
- You cannot translate NX files to CATIA V5 without saving the changes to the NX file. When you select the **Displayed Part** and **Entire Part** options and export a modified NX assembly file to CATIA V5, in the displayed message box you can click **Yes** to save the part and translate it or click **No** to cancel the translation.
- When you import CATIA V5 assemblies (*.catproduct) in NX managed mode, CATIA V5 translator does not generate a hierarchical assembly containing component parts and corresponding geometry.
- When you export an NX part with no BRep on the Windows Operating System, CATIA V5 translator no longer generates an empty CATPart.
- Color is supported on a per face basis.
- You can only import CATIA V5 “Lines and Curves” into NX using default “Linetype” and “Thickness” values.
- You cannot export NX parts with file name containing international characters.
Chapter 10: Teamcenter integration
Product Notes

Active Workspace

Teamcenter Integration works with Active Workspace 2.4 and 3.0.
Launching NX from the Active Workspace web client is not supported on the Mac.

Use internal names for properties when defining preferences for additional columns

Teamcenter object properties can be displayed as columns in Teamcenter Navigator, Assembly Navigator, and file select dialog boxes. The columns are defined by properties in Teamcenter.

The preferences use the display names (localized) of the properties for the column titles in NX, but you must use the internal names of the properties when defining the preferences.

In addition, the applicable preferences are further defined as follows:

• **TC_NX_additional_columns**
  It is expected that these properties are from the WorkspaceObject class. If the properties are not from the WorkspaceObject class, define them as <object type name>:<property name>.

• **TC_NX_additional_item_columns**
  It is expected that these properties are from the Item class. If the properties are custom item types and not from the Item class, define them as <item type name>:<property name>.

• **TC_NX_additional_item_revision_columns**
  It is expected that these properties are from the Item Revision class. If the properties are custom item revision types and not from the Item Revision class, define them as <item revision type name>:<property name>

  Example values:

• **TC_NX_additional_dataset_columns**
  It is expected that these properties are from the Dataset class. If the properties are custom dataset types and not from the Dataset class, define them as <dataset type name>:<property name>

When you define the column configuration preferences (TC_NX_TCNavigator_Column_Config, TC_NX_FileSelect_Column_Config, and TC_NX_ANT_Column_Config), use the exact strings you used to define the additional columns (above).

New refile utility options

The following options are added to the ugmanager_refile utility:

• **-use_default_load_option_file**
  This option uses the specified default load options. It cannot be used with the -y option (the -y option takes precedence).

• **-refile_specified_non_master_only**
This option is used with the -input_list option. While processing the non-master parts from the input list, only specified non-masters are refiled.

**Use Item Name instead of Number customer default**

The *Use Item Name instead of Number* customer default is removed. To specify the display of the Item name or Item ID for an object in NX, specify the desired property as the displayed property in the Teamcenter BMIDE. NX uses the same setting as Teamcenter. This provides consistency for displayed names when viewing objects in Teamcenter and NX.

In addition, the *Always use Item Number for Interpart Expressions* customer default is removed.

**Part number and revision customer defaults**

The *Part Number Prefix*, *Part Number Suffix*, *Part Revision Prefix*, and *Part Revision Suffix* customer defaults are moved to the *Legacy* tab. They are available for systems using legacy display names and to support NX Open programs. The NX Part Display Name is now based on the display name as defined in Teamcenter.

**Variant configuration**

The *Variant Configuration* command is removed. To apply a variant configuration to an assembly, load the assembly using the *Variant Rule* option in the *Assembly Load Options* dialog box.

**Publish Optional Information**

On the *Import Assembly into Teamcenter* dialog box, if *Publish Optional Information* is not selected, the only publishing option that is applicable during import is the *Save JT Data* option (on the *Save Options* dialog box) for creating JT files.

The *Publish Optional Information* option does not affect the publishing of WAVE and drawing relations during import. They are published only for parts that are fully loaded whether this option is selected or not.

If the *Publish Optional Information* option is selected, the following are published:

- QAF files
- TruShape data
- UGPART-Attributes form
- Bounding box
- Weld features. Type of welds depends on the customer defaults selected for welds. Weld occurrences are not supported.
- Product interfaces
- Synchronized assembly arrangements

You cannot select the *Publish Optional Information* option after you have identified the items for import. If the *Publish Optional Information* option is not selected and you perform an action to choose the import items, such as add assembly or import from folder, the option is inactive.
Item types in 4GD assemblies

The Teamcenter preference `ItemRealization_skip_type_list` defines the item types that are skipped when an item assembly is realized into a collaborative design or an existing realization is updated.

In NX, item types in this preference are used to exclude components in an assembly for occurrences having these item types. So NX would skip synchronizing those occurrences when the assembly is loaded. This preference should be used only when you have assemblies that have child components that have no impact on your CAD design. The excluded components do not appear anywhere in NX, including the Assembly Navigator, parts list, and so on. For example, you would use this preference if you added items of type `Note` as children of an assembly and you do not want to see them when the assembly is loaded. When this preference is set, it ignores these types of components during load of the assembly.

In addition, when such an assembly is realized in 4GD as a reuse design element, no subordinate design elements are created.
Caveats

Using Active Workspace embedded in NX

When you run Active Workspace embedded in NX, some minor display issues may occur. These include misalignment of items in lists, cutoff text, and incorrect sizing of elements. In general, these issues do not prevent or severely limit the use of the Active Workspace functionality.

Active Workspace preferences

When Teamcenter installs Active Workspace 2.2, the AWC_NX_OpenSupportedTypes and AWC_NX_AddComponentSupportedTypes preferences are not automatically created. You need to manually create and set these preferences in Teamcenter.

Running refile with escape character

If you set the following Teamcenter preference to # so that # becomes an escape character, refile does not work for a part that contains the # character in its ID.

   TC_escape_character

Starting NX in four-tier Teamcenter environment with WebLogic 10 MP2

When you are running Teamcenter in the four-tier environment with WebLogic 10 MP2, NX may not start with no error messages displayed. This could be due to problems with the WebLogic server.

   Note
   This is applicable only when you are using the WebLogic 10 MP2 Application Server.

Perform the following steps to modify the Weblogic XML file:

1. Stop the WebLogic application and locate the tc.war file in the WebLogic domain (typically in the autodeploy directory).

2. Open the tc.war file using Winzip and extract the weblogic.xml file to a temporary location.

3. Open the weblogic.xml file using an editor (XML or text editor) and add a cookie-http-only XML element with the value of false in the session-descriptor element. For example:

   <session-descriptor>
     ...
     <cookie-http-only>false</cookie-http-only>
   </session-descriptor>

4. In Winzip, delete the old weblogic.xml file.

5. Add the modified weblogic.xml file in your temporary directory into Winzip. To do this, drag the web-inf folder that contains the weblogic.xml file and drop it into Winzip. Ensure the path of the weblogic.xml file is web-inf.

6. Restart the WebLogic application.
Creating an Alt Rep assembly using File New

You cannot have an assembly that is an alternate representation (Alt Rep) that has children that are not also Alt Reps. The part types of the parts (Alt Rep) must match the part type of the assembly (Alt Rep).

However, when you choose File→New to create a new assembly and use the Blank template, NX lets you create an Alt Rep assembly with children that are not also Alt Reps. This causes problems when you use the assembly in NX.

Translators only supported in Teamcenter two-tier environment

Teamcenter only supports the installation of the following NX translators in a Teamcenter two-tier environment, the Teamcenter four-tier environment is not supported:

- NXClone
- NXRefile (not supported on Linux)
- NXtoPVDirect

Teamcenter localizable properties not supported

In Teamcenter, there is now the capability to have the names and values of properties translated and displayed in multiple languages. You can see this functionality in some areas of NX (not all areas of NX incorporate this functionality), such as the Teamcenter Navigator, Part Family template spreadsheet, and New Item, Save, Save As, Import, and component properties dialog boxes. This is applicable for Teamcenter properties such as: property names, property values, list of values, and BMIDE elements (type names).

When you run NX, the language set by the environment variable UGII_LANG determines the language that is used to display the names and values of TC properties in NX.

If you do not have translated values defined in TC for the properties, or you do not want NX to display the translated values, set the following environment variable:

UGII_NO_TC_LOCALIZATION=1

When this environment variable is set, the property values shown in NX are always the internal value (non-translated) and there is no indication in NX that the value has a translated value defined in Teamcenter. This is the same behavior that NX had prior to NX 10. However, the environment variable does not change the way the property names are displayed. If the property name has a translated value that matches the UGII_LANG setting, the translated (localized) name is still shown in NX.

VLA Attribute Affix options modified

The VLA Attribute Affix customer default (Teamcenter Integration for NX→User Attributes, All tab) is modified. The new options [Numeric] and :Numeric introduced in NX 8 caused problems when there are references to VLA (variable length array) attributes in parts created prior to NX 8. The [Numeric] and :Numeric options are now set to _Numeric when selected. You should use _Numeric if you are setting this option for the first time.
Running run_tcbin_import.bat

If you run the run_tcbin_import.bat script at %UGII_BASE_DIR%\ugmanager, go into the script and remove the extra backslash (\) after ".exe" on the command line located near the end of the script such that the command reads:

```
@"%UGII_BASE_DIR%\ugmanager\tcin_import.exe" %*
```
Documentation Notes

Importing part family members as normal parts

There are several ways you can configure NX when importing and exporting part families.

Ignore members – do not include template

If the customer default Ignore Part Family Member – Include Template Part is not selected, the Teamcenter Integration preference Warn on Family Import/Export lets you determine whether family members are imported (or exported) as normal parts. When you select the preference (selected by default), the Part Family Member Import Action dialog box is displayed during the import operation. The following options are available in the dialog box:

- Treat Parts as Lost – Does not import the family members into Teamcenter.
- Turn Family Members Into Normal Parts – Imports the family members into Teamcenter as parts.

If the family members are lost during import (Treat Parts as Lost selected), when you load the assembly into NX, the family members are regenerated.

If you deselect the preference Warn on Family Import/Export, the Part Family Member Import Action dialog box is not displayed and the family member parts are imported (or exported) as normal parts.

The customer default Include Part Family Member Template Part determines whether to include the part family template in the import (or export) operation.

Ignore members – include template

If the customer default Ignore Part Family Member – Include Template Part is selected, the Teamcenter Integration preference Warn on Family Import/Export is not selected and grayed out. During import (or export), the Part Family Member Import Action dialog box is not displayed and the family members are treated as lost. The part family template is included.

Environment variable

The environment variable UGII_UGMGR_ALLOW_PFM_IMPORT_EXPORT takes precedence over the Ignore Part Family Member – Include Template Part customer default and Warn on Family Import/Export preference. If you set the environment variable UGII_UGMGR_ALLOW_PFM_IMPORT_EXPORT=1, the Part Family Member Import Action dialog box is not displayed. The family member parts are imported (or exported) with the family status retained. The Include Part Family Member Template Part customer default determines whether to include the part family template in the operation.

ug_clone utility

If you use the ug_clone utility to import (or export) part families, the Warn on Family Import/Export preference is not applicable. Use the ug_clone fam[ily_treatment]=lose|strip_status option to specify whether to treat family member parts as lost or normal.
Chapter 11:  Mechatronics Concept Designer
Product Notes

PLCOpen XML export for STEP 7

Mechatronics Concept Designer can export the sequence of operation in the standardized XML format PLCOpen XML. To enable import of PLCOpen XML into STEP 7 5.5 SP 2, a hotfix has to be applied to STEP 7. You can find information about this hotfix at the following:

German: http://support.automation.siemens.com/WW/view/de/62861211

The hotfix is also available on the NX Installation DVD.
Chapter 12: Line Designer
Product notes

Template files

The standard part files delivered with Line Designer must be imported (installed) into the Teamcenter database to enable access by the New Item dialog box. If this step is not performed, the New Item dialog box displays only blank templates.

A setup script for installing Line Designer templates in Teamcenter is included with NX:
%UGII_ROOT_DIR%\LINE_DESIGNER\templates\tcin_linedesigner_template_setup.bat

For information about how to use the script, see Install File New templates in the NX help:

Home
  Teamcenter Integration for NX
    System Setup/Administration
      Installing/creating/modifying templates
        Install File New templates
Documentation notes

While Line Designer can work with either BVR or 4GD data structures, typically the documentation describes the 4GD procedures.
Caveats

Fast Placement

Currently, **Fast Placement** works only among components that are under a Plant structure (below a production unit or below a workarea). **Fast Placement** does not work when editing an assembly that is not in the Plant structure.

Assembly load options and Line Designer

Components (smart objects) must be fully loaded for complete functionality. If the assembly load options **Use Partial Loading** and **Use Lightweight Representations** are selected when parts are loaded, the following issues occur.

- Running **Resize Connector** will always display the alert **Entered size and default size of connectors are the same**.
- The **Show and Hide** dialog does not show the Line Designer commands **Show / Hide Connector**.
- Drag&Drop from Reuse Library onto connectors does not work reliably.

Editing smart component sketches

While editing sketches of smart equipment, the 3D object is visible. The sketch nodes can be dragged to edit values.
Caveats (10.0.2)

Manufacturing resource library version compatibility

Line Designer in NX release 10.0.2 is certified for use with factory resources from the Manufacturing Resource Library (MRL) for Teamcenter release 10.1.4.1.

Do not install the factory resources from the MRL for Teamcenter release 10.1.4.

Drag and Drop from Reuse Library does not create connection between components in specific scenario

In certain cases, when you drag and drop components from the Reuse Library, the components may not connect to each other as expected. The workaround for this issue is to manually connect the components using the Connect Components command.

Configured components in the Plant Navigator

Configured components from the plant structure appear as loaded components in the Plant Navigator.
Caveats (NX 10.0.3)

Connections broken on drag and drop between stations

When you drag and drop components between stations, the connections between the components are broken. In BVR structure, the workaround for this issue is to manually recreate the connections using the **Connect Components** command.

Drag and drop from Reuse Library

- On Linux systems, in 4GD, under partitions, dragging and dropping components from the Reuse Library gives an error and does not work.

- In case of large assemblies, dragging and dropping components from the Reuse Library may take more time.
Siemens Industry Software

Headquarters
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 972 987 3000

Americas
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 314 264 8499

Europe
Stephenson House
Sir William Siemens Square
Frimley, Camberley
Surrey, GU16 8QD
+44 (0) 1276 413200

Asia-Pacific
Suites 4301-4302, 43/F
AIA Kowloon Tower, Landmark East
100 How Ming Street
Kwun Tong, Kowloon
Hong Kong
+852 2230 3308

About Siemens PLM Software

Siemens PLM Software, a business unit of the Siemens Industry Automation Division, is a leading global provider of product lifecycle management (PLM) software and services with 7 million licensed seats and 71,000 customers worldwide. Headquartered in Plano, Texas, Siemens PLM Software works collaboratively with companies to deliver open solutions that help them turn more ideas into successful products. For more information on Siemens PLM Software products and services, visit www.siemens.com/plm.